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DATA ACQUISITION
1. INTRODUCTION

1.1. Overview

The Data Acquisition Software is used to control MEG measurement system 
and to acquire data with it. This manual covers performing measurements 
with a system that has been installed, configured and tuned. Software 
installation and basic configuration have been explained in document 
NM24013A-* Data Acquisition Software Release 6.0 Installation Guide. Tuning 
has been described in document NM24011A-* Sensor Tuner User’s Manual.

This manual applies only to Data Acquisition Software Release 6.0. The soft-
ware allows both evoked response measurements and recording of contin-
uous raw data. It also supports Internal Active Shielding (IAS) noise 
reduction system, and provides continuous head position tracking capabili-
ties when used with MaxFilter™ software. The software release 6.0 runs on 
Linux workstations and requires a TRIUX™/TRIUX™ neo system.

1.2. Typographical conventions

The following typographical conventions are used in this manual.
commands

Typed commands and text as well as messages on non-graphical 
screens or windows are shown in typewriter font. For example, com-
mands to be given to the Linux shell are written in this font:

show_fiff -v online.fif

These commands should be typed exactly as shown, including spaces, 
underscores, hyphens, slashes, punctuation etc. only omitting the con-
structions denoting parameters (see below). When using the graphical 
user interface, it is necessary to open a terminal window first in order to 
type the commands.
NM23732A-B1 Introduction 1
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buttons and messages
The textual items of the graphical user interface are denoted with bold 
Helvetica. The names of buttons, menus and menu items and messages 
appearing on graphical windows are shown in this font. For example:

Select Save averages... from File menu.
means using the mouse or arrow keys to point and activate the menu 
labeled as “File”, and then moving the pointer to an item in this menu 
reading “Save averages...” and selecting it.

names and parameters
Text in italics indicates the name of an application program, manual, or 
other specific term. Italics is also used to introduce new concepts and 
to emphasize words.
Parameters are marked with italicized text enclosed in angle brackets 
(<,>). The whole construction, including the angle brackets, should be 
replaced by the value of the parameter. For example, in the shell com-
mand described as

show_fiff -v <data file>
the string <data file> is substituted with a real file name. Optional 
parameters or arguments are enclosed in square brackets.

1.3. Software safety

This product has been designed for the following intended use:

The TRIUX™/TRIUX™ neo systems are magnetoencephalographic (MEG) 
devices which non-invasively detect and display biomagnetic signals pro-
duced by electrically active nerve tissue in the brain. When interpreted by a 
trained clinician, the data enhances the diagnostic capability by providing 
useful information about the location relative to brain anatomy of active 
nerve tissue responsible for critical brain functions.

Warning: MEG data can be inherently explained by many different 
source distributions, and measurements often contain various kinds of arte-
facts. Data used for clinical purposes must be interpreted by a trained clini-
cian who is capable of judging the relevance and quality of the data.

Warning: Do not use the system without also carefully reading TRIUX 
User’s Manual or TRIUX™ neo Instructions for Use.

!

!
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2. GETTING STARTED

2.1. Hardware checklist

Before starting a measurement:
1. Check that you have a set of at least three HPI coils available.
2. Check that the evoked-response stimulation hardware is properly set 

up, if needed.
3. Check that the necessary electrodes, paste, and other related items are 

available for recording electric signals.

2.2. Starting the software

All the Data Analysis and MEGIN Data Acquisition software programs are 
started by clicking the corresponding icon in the Neuromag application 
folder within the desktop’s application menu.

The data acquisition control program (megacq) is started by selecting the 
Acquisition icon. In addition to the main window (see page 4), the raw data 
display appears (see Section 5.3. on page 34).

On start-up, megacq checks the integrity of the data connections from the 
data acquisition system to the workstation. If connections are faulty, an 
error dialog indicating the failure pops up. Should this happen, check first 
that the front-end electronics is switched on (see TRIUX User’s Manual or 
TRIUX™ neo Instructions for Use). Further guidance for resolving possible 
problems can be found in Section 7. on page 45.

Here we assume that the system is tuned and that SSP vectors used in sup-
pression of external artefacts have been set. For details see Sensor Tuner 
User’s Manual and Section 8. “Using signal space projection” on page 46.

Before proceeding it is advisable to check the available disk space on data 
volumes from Disk space… in the Tools menu.
NM23732A-B1 Getting Started 3
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2.3. Components of the control program

The main window of megacq consists of:

1. The menubar with File, On-line, Tools, and Help menus.
2. A log window for informational messages.
3. The setup buttons with a synopsis of the setup state indicated next to 

each button.
4. Acquisition control buttons, which are enabled and disabled according 

to the state of the acquisition process.
5. A stopwatch for measuring time and a toggle for sending EEG calibra-

tion signals during measurement.
6. Five or more status message lines indicating the state of the acquisi-

tion. There is one Averager line for each set of 16 averaging categories.

2.3.1. The menus

The items in the File menu store and recall measurement parameters from 
files, thus facilitating setting up for a measurement. See Section 3.8. “Saving 
and restoring settings” on page 27 and Section 4. “Experiment preparation” 
on page 28 for the details of the items in this menu. Finally, there is Quit for 
exiting the acquisition system.

The On-line menu contains functions which control the on-line averager 
and the on-line average display during a measurement. See Section 5.4. 
“On-line averaging” on page 39 for a description of this menu.

1.

2.

3.

4.

5.

6.
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Most of the functions in the Tools menu control the magnetometer probe: 
Reset channels

Resets the MEG and EEG channels. To ensure fast settling of the signals 
after resetting the electronics the digital high-pass filter is automati-
cally switched to a high corner frequency for a couple of seconds and 
then back to the setup value.
A reset is applied automatically when a measurements starts, so this 
function is intended for recovering channels in the rare case of system 
malfunction.

Tuner...
Invokes the automatic sensor tuner. For details see Sensor Tuner User’s 
Manual.

Helium level...
Shows the liquid Helium level history and estimated zero-level time. 
This can be done also by clicking the Helium icon in the Neuromag -> 
Maintenance folder.

Disk space...
Shows the available disk space on all mounted volumes.

Phantom...
Opens up the phantom measurement control tool. See Section 9. 
“Phantom measurement” on page 49 for details.
NM23732A-B1 Getting Started 5
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2.4. Closing the software

When the measurements are completed and all the necessary data saved, 
the acquisition system user interface can be closed to release computer 
resources for other tasks. To close the acquisition programs select Quit in 
the File menu of megacq. You will be asked for a confirmation.

All the child applications of megacq (raw data display, average response dis-
play etc.) will close automatically. 

The state of megacq is not automatically saved when closing it. Thus, you 
have to explicitly use the procedures explained in Section 3.8. “Saving and 
restoring settings” on page 27 if you want to continue using the same 
parameters.

Note that exiting megacq only closes the user interface of the data acquisi-
tion system, while the system remains powered and the system’s server 
software remain running. These should be shut down only as part of service 
operations. It is preferable to keep the electronics on between measure-
ment sessions; the system requires considerable time to completely stabi-
lize after a power-up. 

The restarting procedure is described in detail in Section 7. “Restarting the 
software” on page 45. The power-up and power-down procedures of the 
MEG system are described in both TRIUX User’s Manual and TRIUX™ neo 
Instructions for Use.
NM23732A-B1 Getting Started 6
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3. SETTING UP
This section describes the setup tasks to be performed before starting the 
acquisition. If the personal data of the subject are available, the setup can 
be completed before the subject arrives. See “Experiment preparation” on 
page 28 for more information. 

3.1. Project

The measured data are grouped into projects according to the conventions 
at each site. For example, one project might correspond to a group of 
patients with common symptoms or patients investigated by one clinician.

The project is selected from the project dialog which appears when the 
project setup button is pressed.

If you are collecting data to an already existing project, just select the proj-
ect name from the list and press OK or double click the project name.

If you are defining a new project, select the item <new> from the list and 
enter the project name and other reference information in the text entry 
areas. The project name may consist of lowercase letters and the under-
score character. In addition to the project name, aims, and names of 
responsible persons are required for the definition of a new project.

If you want to close the project dialog without changing anything press 
Cancel.

There are two useful keyboard shortcuts in the project list. First, you can go 
to the <new> item by pressing the home key with control down. Second, 
you can browse the list alphabetically by clicking any of the items and then 
pressing a letter key. The list will move to the first project name beginning 
with this letter.
NM23732A-B1 Setting up 7
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3.2. Subject

3.2.1. Subject list

The names of defined subjects are listed alphabetically at the top of the dia-
log.

If you are collecting data from an already defined subject, just select the 
subject name from the list and press OK or double click the subject name.

To define a new subject, select the item <new> from the list, enter the 
information to the text fields, select the appropriate choices, and press OK. 
You are required to enter the first and the last name, and the date of birth. 
Do not to define the same subject twice as a double-entry may confuse the 
MEG/MRI subject matching in the analysis programs.

Weight and height are optional whereas handedness and sex are always 
taken from the corresponding option menus. Hospital Information System 
(HIS) ID is intended for a hospital-wide patient code, such as social security 
number, which uniquely identifies the subject. HIS ID is stored with each 
data file and it can be used as a path name component for the saved files.

If you want to close the subject dialog without changing anything press 
Cancel.

The keyboard shortcuts in the subject list are identical to those in the proj-
ect list.
NM23732A-B1 Setting up 8
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3.2.2. Volunteers and patients

Sites studying patients would often like to protect patient information from 
unauthorized access. megacq provides a grouping of persons to be studied 
to ‘volunteers’ and ‘patients’.

Volunteers are healthy subjects participating in the MEG studies. When a 
person is classified as volunteer, megacq applies no special protection on 
the data:
1. The personal data of a volunteer can be read by any user in megacq. All 

personal information is included with the measured data.
2. The data will be saved - by default - in directories

<volume>/<project>/<last name>_<first name>/<date>,
as discussed in Section 6.1. on page 43. All directories on the path are 
accessible to any user.

For a person classified as a patient, the following protective measures are 
taken:
1. Only the patient id number will be written to the data files. The data 

files will contain case as the patient’s first name and the id number as 
the last name. Therefore, if you list the person’s name from a data file it 
will be something like case_567.

2. The data will be saved - by default - in directories
<volume>/<project>/case_<id>/<date>.

3. The creator of the patient chooses the access restrictions which apply 
to the personal data of the patient entered and to the MEG and EEG 
data saved.
In the strict access mode, the data are only readable by the creator of 
the patient.
In the group access mode, read, and write access to the patient data is 
additionally granted to a designated group of users.

The choice between volunteers and patients is made in the option menu at 
the top of the subject definition dialog. When the menu is set to Volun-
teers, all volunteers are listed.

When the menu is set to Patients all patients accessible to the current user 
are listed.
NM23732A-B1 Setting up 9
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If you have created the patient, the Accessible to group: option menu 
becomes enabled.

If the choice is None the data of this patient are only accessible to you (the 
user currently logged in). If you select a group of users, the data become 
accessible to this group as well. Please consult your system administrator if 
you need a new group of users. The number of groups should be kept as 
small as possible.

Note: If you have restarted the acquisition software as described in Sec-
tion 7, you can reuse earlier HPI data when megacq is restarted. However, 
you can change the subject only once (from No subject to some available 
subject) without losing the HPI data.
NM23732A-B1 Setting up 10
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3.3. Acquisition

The acquisition setup dialog, which appears when the acquisition setup 
button is pressed, adjusts the following:

1. The selection of channels to be acquired.
The channels are switched on and off from the corresponding buttons 
in the upper part of the dialog.

Note: All MEG channels are selected by default. Switching any of them off 
should be done with caution. It is better to ignore malfunctioning channels 
in the analysis software instead of not recording them at all. This enables, 
e.g., checking if artefacts on other channels are due to malfunctioning chan-
nel. In addition, some third party analysis tools may assume that all channels 
be present in the data file.

The number of EEG input channels is system specific.
Each of the bioamplifier channels can be denoted either as an unspec-
ified BIO input, or as a specified EOG, EMG, or ECG input. The type and 
other attributes of each bioamplifier channel can be changed in the BIO 

1.

2. 3.

4. 6.

5.

7. 8.

9.

10.
NM23732A-B1 Setting up 11



DATA ACQUISITION
channels editor (see description of the Edit BIO button). The change of 
the input type affects the channel name. This is often useful in the arte-
fact rejection and later stages of data analysis. For example, xplotter, the 
plotting program, may be set up to lay out the EOG channels in a par-
ticular position. Also, the scales of various bioamplifier channel types 
can be separately set in xplotter and in the raw data display.

Channels labeled with STI are stimulus channels whose usage is 
described in more detail in Section 3.4. on page 14.

Channels labeled with MISC are auxiliary electrical input channels.
Channels labeled with SYS are digital system state channels whose 
usage is described in Section 3.5. “On-line averaging” on page 17.
Channels labeled with IAS are Internal Active Shielding system’s chan-
nels.
Channel labeled with EXCI is used internally in tuning. See Section 5.3.4. 
“XY display” on page 38 for more details.

2. The sampling frequency.
The sampling frequency, fs, is set with an option menu below the chan-

nel selectors. It is the same for all channels.
The sampling rate cannot be set lower than 3 times the highest HPI coil 
frequency.
The actual sampling rate may slightly differ from the selected one 
because of limitations in the hardware. However, the real sampling rate 
is reported in the data files and in the information window on top of the 
main acquisition window.

3. Low-pass filter
The low-pass filter corner frequency, fa, is set with a text field to the 

right of the sampling frequency. It applies to MEG, EEG, MISC and IAS 
channels. The BIO channels have their own low-pass filter corner set-
tings (see list item 10).
The actual filter corner may differ somewhat from this setting. The real 
corner frequency is saved into data files and reported in the informa-
tion window. For more detailed low-pass filter specifications consult 
the TRIUX™/TRIUX™ neo Technical Manual.

According to the Nyqvist criterion, the sampling frequency should be at 
least twice the highest frequency component in the analog signal, 
fs > 2fa to avoid aliasing. Since analog filters cannot have an infinitely 

steep transition at the corner frequency, megacq adds a safety margin 
and only allows fs > 3fa. 

4. High-pass filter
The corner frequency of the MEG channels’ high-pass filter can be set in 
steps. The available corner frequencies can be selected from an option 
menu. The EEG and BIO channels have their own high-pass filter corner 
settings (see list items 7 and 10).

5. Raw data baseline
With this option, it is possible to define the amount of data to be saved 
preceding the time when raw data saving was switched on. The length 
of this ‘baseline’ will be at least the indicated amount. The maximum 
length is 15 seconds. This feature allows keeping the raw data saving 
off until something interesting happens. When saving is activated, the 
event noticed can be saved, even though it has already gone.

6. Internal Active Shielding
This option is present only in systems having Internal Active Shielding. 
The toggle button is used to activate or deactivate the internal feed-
back system. See Internal Active Shielding User’s Manual.

7. EEG high-pass filter
NM23732A-B1 Setting up 12
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The corner frequency of the EEG channels’ high-pass filter can be set in 
steps. The available corner frequencies can be selected from an option 
menu.

8. EEG gain
The total gain of the EEG input circuitry (applies to all EEG channels) can 
be selected in steps with this. The available gain settings are shown in 
an option menu.

9. EEG/BIO Active ground
Selecting this will refer EEG and BIO channels to an active ground, oth-
erwise the EEG electronics isolated ground is used. See TRIUX User’s 
Manual or TRIUX™ neo Instructions for Use.

10. Edit BIO button
This button pops up the BIO channels editor, which is used to configure 
the BIO channels individually. The editor is shown in the following fig-
ure.

The buttons of the top row will apply the particular settings to all BIO 
channels. 

The button in the first column allows to switch the BIO channel on and 
off. The selection state is automatically copied to the acquisition setup 
dialog and vice versa.
The option menu in the second column allows to specify the channel’s 
type as either BIO, EOG, EMG or ECG. The channel’s selection buttons (in 
this dialog and in the acquisition setup dialog) are renamed accord-
ingly.
Rest of the columns allow to set the channel’s low-pass and high-pass 
filter corner frequencies and the channel gain. Note that low-pass fields 
(in this dialog and in the acquisition setup dialog) are automatically set 
to the maximum allowed value when the sampling frequency is 
changed.
NM23732A-B1 Setting up 13
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3.4. Stimuli and triggers

The electrical stimulus triggers, that mark events for the acquisition soft-
ware, can be provided either by the data acquisition unit or by an external 
stimulation system. The acquisition software processes the trigger signals 
exactly in the same way, independent of their origin. This section describes 
the trigger system and generation of triggers.

3.4.1. Trigger interfaces and triggering modes

The electric interface of the trigger signals is called a Stimulus Trigger Inter-
face Unit, which is connected to the System Control Card (SCC) housed in the 
data acquisition system cabinet. TRIUX™/TRIUX™ neo systems include two 
such interface units, which by default operate in parallel, i.e. input #1 and 
output #1 on both interface units correspond to trigger line #1 on the com-
bination trigger channel (STI101) associated with the 1st interface unit. 
However, the two interfaces can also be treated separately by turning on 
(selecting for acquisition) the trigger channel (STI102) associated with the 
2nd interface unit. This is done using the acquisition setup dialog.

For details about the Stimulus Trigger Interface Unit and for electrical speci-
fications of the trigger pulses, see TRIUX User’s Manual or TRIUX™ neo 
Instructions for Use, as well as TRIUX™/TRIUX™ neo Technical Manual.

The SCC manages both internal and external triggers. Irrespective of the 
triggering mode (internal/external) the trigger pulses always appear at the 
corresponding trigger outputs of both interface units. The principle is 
shown in the following figure.

Internally generated trigger pulses and the pulses acquired from external 
sources are logically OR’ed line by line. The pulse is fed to the acquisition 
system and to the trigger outputs. Thus the system automatically ‘chooses’ 
the right source for each trigger channel provided that a trigger channel is 
not receiving pulses both from internal and external sources at the same 
time. Should this happen, pulses from those two or three sources will be 
intermixed and indistinguishable at further processing stages.
NM23732A-B1 Setting up 14
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Typically the trigger event is associated with the rising edge of trigger 
pulse, however, the analysis tools can be configured to also monitor the fall-
ing edge. Note that the timing of the falling edge does not accurately 
reflect any physical event in systems which incorporate circuitry that fixes 
the pulse length. See Section 3.5.3. “Events” on page 18 for more details.

The stimulus setup dialog shown below selects the trigger source from the 
software point of view: if internal triggering is selected, you are allowed to 
define a stimulus sequence.

If you prefer external triggering, turn the switch to the external position 
and connect a TTL level trigger pulse output from your stimulation system 
to the trigger input.

Note: Both internal and external triggers can be used in the same session.

3.4.2. Stimulus sequence

The stimulus setup dialog appears when you press the stimulus setup but-
ton.

Each item in the internal stimulus sequence is defined by the trigger num-
ber (1 – 16), the length of the trigger pulse (ms), and the length of the inter-
val from the start of the trigger to the next. This period is often called the 
inter-stimulus interval (ISI).

The maximum length of the sequence is 500 stimuli. The minimum pulse 
length is 5 ms and the minimum ISI is 50 ms. There must be at least 40 ms 
from the end of the trigger to the next.
NM23732A-B1 Setting up 15
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The stimulus sequence can be either entered manually, generated with 
help of the sequence generator, or loaded from a file.

3.4.3. Sequence generator

The sequence generator utility is accessed trough the Generate button in 
the stimulus definition dialog.

You can create several kinds of sequences:
1. An alternating sequence

Given number of stimuli, n, are repeated sequentially: 
1,2,…,n,1,2,…,n,… If the ISI limits are equal, the ISI remains constant; if 
they are different, the ISI’s are random within the interval with a uni-
form probability density.

2. Random sequence
The given number of stimuli have an equal probability to occur in the 
random sequence. The handling of ISI’s is the same as in the alternating 
sequence.

3. Mismatch sequence
Rare (deviant) stimuli occur randomly with given probability in a 
monotonous sequence of standard stimuli. If the deviant probability is 
less than 15 percent, two deviant stimuli will never occur sequentially. 
Normally stimulus 1 is the standard and stimulus 2 the deviant. If the 
deviant probability is set to higher than 85 percent, the roles of the 
stimuli are reversed.

Once you click Generate, the sequence is generated and the values are 
entered into the stimulus sequence table.

3.4.4. Loading and saving sequences

You can load stimulus sequences from text files and save existing 
sequences for future retrieval. By default, the stimulus-sequence files are 
stored in the directory /neuro/dacq/stim.

You can also generate sequence files yourself either with a text editor or 
with a program. The sequence file simply replicates the sequence table:

<trigger #1> <length 1/ms> <ISI 1/ms> 
<trigger #2> <length 2/ms> <ISI 2/ms> 
…

Space, tab, and newline are allowed as separator characters between the 
numbers.
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3.5. On-line averaging

3.5.1. Basics

The most complex part of the acquisition setup concerns on-line averaging. 
For the discussion to follow we need to define a few relevant concepts first.
Trigger channel

An electric impulse carrying solely timing information and occurring on 
a single digital line is called a trigger. A trigger could be used to drive a 
stimulator to produce a stimulus, or it could reflect subject’s behavioral 
response. Triggers are generated by the system described in Section 
3.4.1. The output of that system controls the on-line averager.

The system has several trigger channels for recording trigger pulses. 
STI1 to STI16 contain analog-like signal of a single trigger line and are 
provided for backwards compatibility. STI101 and STI102 carry bit com-
binations describing state of the two interface units. Each bit corre-
sponds to one of the trigger lines of the boxes. SYS101 and SYS201 
carry bit combinations for triggers generated by internal events, like 
HPI and phantom.

Event
A transition from an inactive to active state or vice versa on one or more 
trigger lines is an event. The source of an event can be either a stimulus 
trigger or a trigger associated with an action performed by the subject, 
such as a button press.

To avoid misinterpretations of the trigger combinations due to race 
conditions, the following procedure is implemented in the on-line 
averager. Assume sample k with all trigger lines inactive followed by 
sample k + 1 having one or more active trigger lines. Sample k + 1 is 
used as the timing reference, but the trigger line combination is deter-
mined from sample k + 2. This allows a slight asynchrony between the 
on-sets of the trigger lines.

Epoch
An epoch is a section of the incoming continuous data, defined by the 
occurrence of an event and the time limits tmin and tmax with respect 

to that event. We will call the event determining the zero time of an 
epoch a trigger event.

Category
A category defines the epoch to be averaged, any additional conditions 
to averaging, and the processing of epochs during averaging. For 
example, some categories may be set up to produce, in addition to the 
standard average, several subaverages of, say, eight consecutive 
epochs each.
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3.5.2. On-line averaging dialog

The on-line averaging dialog appears when you press the on-line averaging 
button. The events are defined in the top part as described in Section 3.5.3. 
The categories are defined in the middle part as described in Section 3.5.4. 
The artefact rejection and miscellaneous settings are defined in the bottom 
part as described in Section 3.5.5, Section 3.5.6, and Section 3.5.7.

3.5.3. Events

The Event characteristics section in the top part of the on-line averaging 
dialog is used to define the events used in averaging. There are 32 event 
lines, each of which contains a Change... button and a description of the 
event properties.
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The dialog appearing from the Change… button contains the following 
controls.

Name:
A text field to enter a descriptive name for the event. Spaces are not 
allowed.

Channel:
An option menu to select a combination trigger channel.

Old Value/Mask and New Value/Mask:
These fields define the trigger channel state transition that is mapped 
to this event. The Old fields define the state of the triggers before the 
transition, and the New fields define the state after the transition.

First Old Value and previous bit combination are logically anded with 
Old Mask. If the resulting values are equal, then New Value and next bit 
combination are logically ANDed with New Mask. If the resulting values 
are again equal, then transition is considered to have taken place.

Bit 01 corresponds to trigger line 1 and so on. Each Value/Mask pair can 
be entered directly as two decimal bit combination values. Alterna-
tively each bit can be toggled separately such that ‘0’ changes to ‘1’, ‘1’ 
to ‘*’, and ‘*’ back to ‘0’. Asterisk stands for ‘do not care’ and is added to 
Mask.

Delay to stimulus:

A text field used to enter a delay (in ms) from the trigger state transition 
to the actual stimulus. For example, if you have plastic tubes with 
known transmission delays leading auditory stimuli to the subject’s 
ears, enter the delay here to set the time scale of the responses cor-
rectly. The delay must be defined positive if the stimulus occurs after 
the trigger and negative if it occurs before the trigger.

Name:
A text field to assign a comment to the event.

For backwards compatibility, the default definitions of the events corre-
spond to the transitions on the trigger lines as follows (Old Value/Mask is 
set to 0/63 and New Mask is set to 63):
Event # Trigger lines to activate 

1 1 
2 2 
3 3 
4 4 
5 5 
6 6 
7 1 & 2 
8 1 & 3 
9 2 & 3 
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10 1 & 2 & 3 
11 1 & 4 
12 2 & 4 
13 1 & 2 & 4 
14 3 & 4 
15 1 & 3 & 4 
16 2 & 3 & 4 
17 1 & 2 & 3 & 4

Note: As described in Section 3.5.1, event numbers do not directly relate 
to category numbers. For example, event # 1 may be used as a trigger in sev-
eral categories, not necessarily including category # 1. Therefore, if you ad-
just the delays of some events, keep in mind that event # 5 is not always 
triggering category # 5.

3.5.4. Categories

The Averaging categories section in the middle part of the on-line averag-
ing dialog is used to define the categories to be averaged. There are 32 cat-
egory lines, each of which contains the following items:
On-off toggle

A toggle button to activate and deactivate a category. You can often 
define all categories you need in a study consisting of several consecu-
tive acquisitions and then just switch the categories on and off as 
needed.

Display on-off toggle

This toggle button sets the on-line display state of a category. The 
states of these buttons define the initial selection of categories dis-
played in the xplotter window during averaging. The selection of dis-
played data can be modified during acquisition as discussed in Section 
5.4.4. However, when the acquisition is finished, the final results from 
any categories which have one or more epochs averaged will be dis-
played regardless of the on-line display selection. Note also that any 
changes made to the on-line display selection during the data collec-
tion will remain in effect for the subsequent acquisitions. 

Change…
This button invokes a dialog to define the characteristics of a category.

Description
A text describing the properties currently selected for this category 
from the category definition dialog.

The dialog appearing from the Change… button contains the following 
controls:
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Ref. event:
An option menu to select the trigger event. The event is considered as 
the zero-time point, with the optional stimulus delay compensation 
taken into account (see the previous subsection on Events). The event 
name list reflects the defined events in the top part of the on-line aver-
ager window.

tmin:
The start time of the averaging window with respect to the reference 
event. This value can be negative (prior to the occurrence of the refer-
ence event) or positive (after the occurrence of the reference event).

tmax:
The end time of the averaging window with respect to the reference 
event.

Req. event:
An option menu to select the condition event. If None is selected, there 
is no condition.

When:
An option menu to select Before or After. If Before is selected, the con-
dition event must occur before the trigger event. In case of After, the 
condition event must occur after the trigger event.

Within:
The time range within which the condition event must occur in order 
for an epoch to match this category.

Desired # of averages:
If this number is zero or negative, the number of epochs averaged is 
controlled manually, see Section 5.1. on page 30.
If the setting is positive, averaging is automatically suspended when 
the desired number of averages is reached. You can then either con-
tinue averaging manually or stop the measurement.
If several categories have the desired number of averages set, the first 
one to reach the limit causes the averaging to be suspended. Other lim-
its not satisfied remain active. Therefore, if you continue averaging 
manually, the averaging will be again suspended if some other cate-
gory reaches the limit.

Subave. size:
If this number is set to M > 0 both normal and alternating subaverages 
are computed consisting of M epochs. If we denote the epochs by ek(t), 

the jth normal and alternating subaverages are

and 

,

respectively.

Note: M should be an even number to get proper alternating sub-averag-
es.

Comment:
A text entry field to annotate a category with a comment. The comment 
is shown when new data are loaded for plotting and source modeling.

ej t( ) ek t( )
k 1 j 1–( )M+=

jM

=
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3.5.5. Artefact rejection

There are three kinds of artefact rejection criteria available for MEG and EEG 
channels. Each of these can be turned off by entering a negative number 
into their control field.
Amplitude (Max)

The peak-to-peak amplitude within an epoch must not exceed this 
value. Typical value is 3000 fT/cm for gradiometers and 3000 fT for 
magnetometers. This criterion depends on the residual noise within 
the magnetically shielded room.

Slope
The epoch is subdivided into four equally long pieces. The averages 
over each piece is calculated. None of the three differences between 
subsequent partial averages must not exceed this value. By default, this 
criterion is not in use.

Spike
The absolute value of the difference between any sampled value in an 
epoch and the average of 20 previous values must not be larger than 
this. By default, this criterion is not in use.

The above criteria are applied to all MEG and EEG channels. If a channel not 
meeting the criteria throughout the epoch is found, the epoch is rejected. 
Some channels can be excluded from the artefact rejection during acquisi-
tion, see Section 5.4.3.

BIO, EOG, EMG, and ECG rejection is only possible on the basis of the ampli-
tude criterion.

In addition to the above criteria, an epoch up to a given time interval after 
the reference event can be excluded from the rejection (Ignore (ms) after 
stim). This is useful if a strong stimulus artefact is expected.

3.5.6. Noisy and silent channels

It sometimes happens that few MEG channels are either showing no signal 
or are very noisy. There are two additional parameters to check these chan-
nels: MEG no signal and MEG noisy.

If the peak-to-peak amplitude of a channel is less than the MEG no signal 
limit or larger than the MEG noisy limit, the channel will be omitted from 
further artefact checking during the current and all subsequent epochs. 
The noisy and silent channels so detected will be marked ‘bad’ in the result-
ing evoked-response data files.

The signals of “noisy” or “silent” channels are stored in the very same way as 
those of any other channels; the automatic detection only affects rejection 
checking.

3.5.7. On-line display updates

During on-line averaging the progress is displayed by showing data aver-
aged so far in the standard plotting program (xplotter). 

By default this display is updated every 15 seconds. You may want to set 
this value higher in order to work with the data between updates. It is also 
advisable to set the update interval higher if the ISI is small (< 500 ms), if the 
sampling rate is high (> 1 kHz), the epochs are long (> 2 s), or if many cate-
gories are selected to the on-line display. If the updates are too frequent, 
the on-line averaging may not proceed in real-time and, consequently, you 
may have to wait at the end of the acquisition for on-line averaging to com-
plete.
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3.6. Head digitization

In order to be able to locate signal sources relative to the head, one must 
know the position of the head within the probe. For this purpose we use a 
head position indicator (HPI) system. Before the measurement, one 
attaches small coils to the head and digitizes their locations on the head. 
These coils are then used during the measurement to measure the location 
of the head. Following sections describe the coordinate systems used and 
how the digitization is performed.

3.6.1. Coordinate frames

The TRIUX™ systems internally use device coordinate system. The recorded 
signals represent field components at fixed sensor locations in the device 
coordinate system. The origin of this coordinate system is located at the 
center of the posterior spherical part of the helmet with x-axis from left to 
right, y-axis pointing from back to front, and z-axis pointing up. Thus the 
position of subject’s head in respect to the measurement probe does not 
affect the way the signals are recorded.

The results of source modeling calculations are presented in a more rele-
vant coordinate system, namely the head coordinate system (also called the 
anatomical coordinate system). This is essential in order to integrate the 
source model into an anatomical image, e.g. magnetic resonance image.

The head coordinate system is defined as follows: The x-axis passes through 
the preauricular points with positive values on the right, the y-axis will be 
perpendicular to the x-axis, passing through the nasion and the positive 
axis pointing towards the nose, and the z-axis will point up, perpendicular 
to the xy-plane. This is illustrated in figure below. LPA and RPA stand for the 
left and right peri- or preauricular points, respectively. LPA, RPA and nasion 
are called the anatomical landmarks or cardinal points.

To establish the coordinate transformation between the head coordinate 
system and the device coordinate system the anatomical landmarks have 
to be expressed in the device coordinate system. This is done indirectly by 
using HPI coils whose locations can be measured with respect to the ana-
tomical system and also with respect to the device coordinate system. The 

y

x

z

LPA

RPA

Nasion
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former measurement is called Head digitization and the latter HPI measure-
ment. The combination of these two measurements results in a coordinate 
transformation between device coordinate system and head coordinate 
system.

3.6.2. Digitization

The final task before starting the measurement is the digitization of the 
anatomical landmarks on the head and the position of the HPI coils with 
respect to them.

When you click the HPI Change button, megacq connects to and initializes 
the 3D digitizer used for this purpose. Digitizer initialization takes a few sec-
onds. You are informed about this in a dialog. Once the initialization is com-
plete the HPI dialog appears.

The left section of the dialog contains the controls for the tasks which are 
necessary to complete the HPI procedure. The lower right section (Addi-
tional data) contains controls for optional items. The label above the dia-
log buttons will dynamically indicate the task to be performed next.

The operation of the digitizer, and how to attach HPI coils are described in 
more detail in TRIUX User’s Manual as well as in TRIUX™ neo Instructions for 
Use.

Proceed as follows with the digitization:
1. Attach the HPI coils on the head. Typically the coils are placed so that 

two are behind the ears as high as possible without being on the hair, 
and two on the forehead well separated but not on the hair. The coil 
locations must be covered by the MEG sensor array and they must not 
move relative to the head during the measurement. The coils should 
not be directly under the IAS reference channels, i.e. they should not be 
in the middle of forehead, on the inion or near pre-auricular points.
The most precise HPI information is obtained when the coils are as far 
apart as possible but still within the sensor helmet. Try avoiding situa-
tion where coils form a nearly perfect square.

2. The digitization system is equipped with goggles which track head 
movements during the digitization. Place the goggles firmly on the 
subject’s head and tighten the strap. Check that nasion and the coil 
centers are still accessible with the digitizer stylus.

3. Make sure the digitization chair is sufficiently far (over 1.5 m) from large 
metal objects as they severely distort the digitizer and compromise its 
accuracy. Tell the subject to avoid excessive head movement.

4. Digitize the anatomical landmarks which define the head coordinate 
system: the nasion and the two auricular points. Depending on your 
preferences you may use either peri-auricular or pre-auricular points. 
Be sure to record which points were used to be able to correctly identify 
them later on the anatomical MR images.
To digitize, position the tip of the 3D digitizer stylus at the desired point 
and click the corresponding button in the HPI dialog. It is best to have 
two people available for the digitization: one to position the stylus and 
another to operate the program. Alternatively, the stylus button can be 
used for the digitization: click the Coordinate frame alignment but-
ton to start the “single operator” mode. Then digitize the landmarks in 
any order; the system will automatically associate the points with 
proper landmarks.
The coordinates next to each button indicate the digitized position in a 
coordinate frame tied to the signal source of the digitizer behind the 
chair. The results are averages of three sequential readings taken from 
the digitizer. If they differ from each other by more than 2 mm, an error 
message telling to keep the pointer steady appears and you can re-dig-
itize the point.
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5. When the digitization of the cardinal points is complete, press the 
Align frame button (the alignment is done automatically when operat-
ing with the stylus button and all three landmarks are digitized). The 
coordinates of subsequent readings will be given in the head coordi-
nate frame, tied to the cardinal landmarks.
When Align frame is pressed, the coordinates of the cardinal locations 
will change to the head frame. Notice that the z coordinates of all three 
points are zero. The y coordinates of the auricular points are zero with 
a positive x coordinate on the right and a negative on the left auricular 
point, respectively. The nasion has a zero x coordinate and its y coordi-
nate is positive. The auricular points are usually rather symmetrically 
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located: their x coordinates are opposite and about of equal magni-
tude. This serves as an additional check that the digitized values are 
reasonable.

6. Digitize the HPI coils (order does not matter). 
7. If scalp EEG channels are selected for acquisition, the program moves 

on to digitize the EEG electrode locations. Alternative electrode digiti-
zation sequences for different EEG caps can be configured by editing 
text file /neuro/dacq/setup/eeg_digit_maps. A sequence is specified 
on one line and contains a name, a colon, and a colon separated list of 
electrode numbers (where 0 stands for the mandatory reference elec-
trode). The sequences which contain K+1 electrode numbers (where K 
equals number of selected EEG channels in the acquisition setup dia-
log) are available for selection in the EEG digitization quadrant of the 
window. The option menu also contains one generated sequence, 
called Sequential, which contains electrode numbers from 0 to K, in 
ascending order.

8. You can digitize additional points to obtain information about the head 
shape, which allows more accurate alignment with the anatomical MR 
images. Press Man to digitize the location of the stylus in the “two oper-
ator” mode or Pen to use the stylus button. Click String (enabled sepa-
rately) to digitize continuous runs of the digitizer pen (see “String 
digitization (sweep mode)” on page 26 for more details of the usage). 
Select one or more of the digitized extra points from the list and press 
Delete to remove any unneeded entries. Select two points in the list 
and press Dist? to find out the distance between the selected points. 
The coordinates of the additional points will be saved into the mea-
surement files. Once you have completed the digitization, press OK.

The digitization procedure and other pre-measurement setups can be per-
formed also on a workstation other than the acquisition workstation even 
when there is a measurement in progress. See “Experiment preparation” on 
page 28 for more information.

Note: If you press Cancel in the dialog you will loose all the digitized data. 
A warning dialog will appear to confirm this.

3.6.3. Using less than five coils

By default systems are configured to have five coils. If you only digitize the 
first three or four coils, the system will then use only those coils.

3.6.4. String digitization (sweep mode)

The string digitization mode allows one to sweep the pen freely, e.g. across 
the subject’s head, and automatically digitize points along the movement. 
The digitization starts right away when you click on the String button, so 
position the pen first to the start point of the sweep and then click the 
String button. Subsequently, all movement of the stylus will be digitized 
until either the stylus button is clicked to pause digitization or the Done
button is clicked on the dialog window to finish the sweep mode digitiza-
tion. When paused, the digitization can be continued again by clicking the 
stylus button again. The digitized points are displayed on the screen after 
finishing the digitization with the Done button on the dialog. By clicking 
Abort, the strings digitized will be forfeited.

Use the String step/mm setting to control the point density of  
the digitization (default 2.0 mm).

The string digitization support is turned on by setting variable DEFiso-
trakStrokes in file /neuro/dacq/setup/megacq.defs.local
to value of 1.
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3.7. Gantry position

Before starting a measurement, one should make sure that Gantry posi-
tion in the megacq main window reflects the current dewar position. The 
adjacent gantry position setup button can be used to automatically detect 
the current position. If this fails, a dialog pops up and allows you to manu-
ally change the position to Upright 68 degrees, Upright 60 degrees or 
Supine. The gantry position is also automatically detected when the Start
button is pressed.

Correct gantry position is required for proper operation of IAS and SSP. See 
“Using signal space projection” on page 46.

Note: Do not change the gantry position when a measurement is run-
ning. The system is not able to detect the change of the gantry position after 
the acquisition has been started, and the file format allows saving only one 
gantry position per measurement. Incorrect gantry position in the measure-
ment file can reduce the quality of the analysis results. If IAS is used, the qual-
ity of raw data may also be reduced significantly or the system may become 
inoperational. If you have accidentially left the acquisition running when 
changing the gantry position, stop the measurement and don’t save the 
data if the data collection was on.

3.8. Saving and restoring settings

All of the above settings apart from the project and subject data can be 
saved between sessions. Settings are saved specifically for each project. 
Therefore, you cannot save or load settings prior to selecting a project.

Settings are saved and loaded with the Save settings… and Load set-
tings… items in the File menu. When you save settings you must provide a 
descriptive name for the setup. This name is shown in the list of available 
settings when you load the settings back later.

The settings are also included with the measured data. By choosing Load 
measurement settings… from the File menu you can locate a data file 
and load the settings from that. This option is useful if
1. You would like to replicate a measurement with identical settings.
2. You would like to check the actual settings used afterwards.

Note that the Head digitization data (see Section 3.6. on page 23) are not 
stored in the settings nor can they be loaded from a data file. On the con-
trary, subject preparation information includes everything that is in the set-
tings as well as the digitization data. You can create a preparation from the 
current setup and digitization by choosing Save preparation from the File
menu and recall it later by choosing Load preparation... in the same 
menu. See Section 4. on page 28 for more details.

Note: Using settings or preparations which are copied from some other 
system is not supported. Loading such files can alter the configuration of the 
system so that it no longer matches the hardware of the system.
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4. EXPERIMENT PREPARATION
As discussed in Section 3.8, the acquisition and averaging parameters can 
be saved between sessions using the Save settings… and Load set-
tings… items in the File menu. Therefore, a given experimental paradigm 
can be easily repeated.

It is often beneficial to save all measurement parameters, including the 
project and subject selections, all acquisition and averaging parameters, 
and the head digitization data for subsequent use. This complete set of 
information is called a preparation.

4.1. Restricted megacq

An experiment can be prepared either from the standard megacq or from 
its restricted version. The restricted version is started by double clicking the 
Acquisition Preparation icon in the Neuromag folder.

The restricted megacq does not communicate with the acquisition hardware 
(only certain software modules), and the acquisition control buttons (see 
Section 5.1) are absent. A new experiment can be prepared from another 
workstation while data are being collected at the acquisition workstation. 
The experiment preparation workstation has to be located near the digi-
tizer for feasible digitization.

Note: You can also use the restricted megacq to check information about 
a subject or a project during off-line analysis without disturbing the mea-
surement.

4.2. Saving a preparation

Before you can save a preparation, you will have to complete the following 
steps:
1. Select a project
2. Select a subject
3. Enter the acquisition, stimulus, and averaging parameters or load one 

of the settings available for the selected project.
4. Perform the head digitization.

With all the above data complete you can save the preparation by selecting 
Save preparation from the File menu. If some of the required data is miss-
ing an error dialog will appear. If all data is present, the preparation will be 
saved. You will be informed about the name given to the preparation. The 
name is of the form 

<project name> / <subject name> / <date> <time>.
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A saved preparation will be kept for 24 hours from its creation time. When-
ever megacq or its restricted version is started, the preparation database is 
checked for old preparations which are automatically discarded.

Note: Using the head digitization data from the preparation is only mean-
ingful if the HPI coils are kept attached on the subjects head from the prep-
aration time to the actual measurement.

4.3. Loading a saved preparation

When Load preparation… is selected from the File menu, a list of avail-
able experiment preparations will appear. You can easily identify the 
desired one from the descriptive name. Please be careful to select the cor-
rect one. There is no way for the program to check that the subject to be 
measured is the one you claim him/her to be.

If necessary, you can override any of the data in the preparation simply by 
redoing the relevant parts of the settings. For example, you can redo the 
head digitization, if there is any doubt that the HPI coils are not at the same 
positions as they were at the time of the preparation.
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5. ACQUISITION
Once the setup is complete, subject is seated under the magnetometer, the 
HPI coils and EEG electrodes have been connected as described in the hard-
ware manual, and the shielded room door is closed, you can start the actual 
acquisition.

5.1. Acquisition controls

The acquisition control buttons are:

1. GO!/Restart

Press GO! to Start the acquisition. If the parameters have been changed 
or if this is your first acquisition, the acquisition system is informed 
about the new parameters first. Thereafter, the magnetometer elec-
tronics is set to the correct state including analog filter settings.

Depending on the changes needed this procedure may take about 5 - 
10 seconds. The log window shows messages about the conversation 
with the data collection server. Once the setup is complete, a New 
measurement is starting… message appears on the first message line 
below the acquisition control buttons.
When data collection is started, this button changes to Restart. You 
can then restart the acquisition by clicking this button. All raw data and 
on-line averages collected will be discarded and you can also redo the 
head position measurement (see Section 6.2).

2. Stimulate
When using internal triggering, this button becomes enabled when the 
data collection is started. You can then engage the internal triggers 
with this button. This button does not apply when using external trig-
gering.

3. Average
With at least one active category, the button is enabled when data col-
lection is started. You can then switch on-line averaging on and off by 
clicking this button. If there are no active averaging categories, this but-
ton remains dimmed. 

4. Record raw
Recording of raw (spontaneous) data is independent of on-line averag-
ing. You can switch the raw data recording on and off at will during the 
acquisition. The amount of data collected in seconds and megabytes as 
well as the space remaining on the acquisition hard disk is displayed on 
the second message line of megacq.

5. cHPI
This button is enabled when a normal HPI is done. You can then switch 
continuous HPI on and off by clicking this button. If HPI is not digitized 
or you have decided to omit HPI localization, this button remains 
dimmed. See also “Continuous HPI” on page 33.

6. Stop
Press to finish the acquisition, see Section 5.7.

1. 2. 3. 4. 5. 6.

7.
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7. EEG Calibration signal
This toggle button creates a rectangular 1 Hz signal to EEG and BIO 
channels. The signal can be used to check the EEG system operation at 
the start and end of a measurement. This cannot be activated simulta-
neously with EEG impedance measurement.

Sometimes it might be necessary to reset the MEG and EEG channels after 
an excessively strong magnetic or electric disturbance. This can be done 
while a measurement is in progress by selecting Reset channels from the 
Tools menu. On-line averaging and raw data recording should be turned 
off before doing reset and they should be kept off until all the channels 
have settled again. Otherwise the data could be spoiled by the huge signals 
involved in the reset operation.
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5.2. Head position indicator

If you have digitized the HPI coil locations as described in Section 3.6.2, you 
can localize subject’s head with respect to the neuro-magnetometer. Nor-
mal HPI measures the head position at the beginning of the measurement. 
The result is saved into the data file. Continuous HPI allows determining the 
head position during the measurement. This requires extra processing of 
the data file after the measurement is completed.

5.2.1. Normal HPI acquisition

If the HPI coils have been digitized, the system automatically pops up an 
HPI measurement dialog when data collection is started. This dialog gives 
you the following choices:
Measure

Measure the magnetic field generated by current fed into the HPI coils 
and determine the location of each coil. During the measurement you 
will see messages on the last message line of the megacq main window. 
If no signals are seen or if they are considered too noisy, you will get an 
error message. Should this happen, check that the coils are properly 
connected and that the coils are working properly by rechecking them 
with the HPI coil tester.
Once the measurement is complete, the positions are fitted. When the 
fit completes, the results are reported as described in Section 5.2.2 
below.
The HPI procedure takes usually less than 10 seconds.

Reuse
If you have performed a successful HPI measurement within this ses-
sion and you have not re-digitized the head, you can reuse the previous 
head position. Use this option with caution. If you have any doubt that 
the head has moved since the last HPI measurement, use the Measure
choice instead.

Omit
Do not perform HPI localization at all.

5.2.2. HPI fitting

When the HPI signals have been acquired, a fitting program is started to 
find out the locations of the coils. HPI fitting takes from three to ten sec-
onds. When the fitting is complete, you will see a dialog with the following 
information:
1. Locations of the HPI coils in the device coordinates (see Section 3.6.1 for 

the definition).
2. The goodness-of-fit value for each coil with an indication of accep-

tance.
3. Distances between the coils as measured by the digitizer.
4. Distances between the coils from the fitting procedure.
5. A list of discrepancies between the distances measured by the digitizer 

and calculated from the fitting procedure. Distances larger than 5 mm 
are indicated, suggesting a need to redo the HPI measurement.

6. Location of the head coordinate system origin in device coordinates.
7. Suggestion from the fitting program to accept or reject this result.

With the buttons at the bottom of the dialog, you can either accept the HPI 
data, redo the measurement, or omit HPI localization.
NM23732A-B1 Acquisition 32



DATA ACQUISITION
Note: If you stop the acquisition and you have neither accepted nor dis-
carded the HPI result, no HPI data will be available in the files produced 
when you save the data.

5.2.3. Continuous HPI

The system also supports recordings with continuous HPI (cHPI). Using con-
tinuous HPI requires that a normal HPI measurement is performed at the 
beginning of the measurement. When this has been done, the cHPI button 
becomes available, and the user can activate the HPI coils. This will lead to a 
measurement which contains both the brain signals and the cHPI signals.

In order to judge the data quality during the cHPI measurement, a low-pass 
filter should be used in the raw data display. By setting the filter corner fre-
quency suitably, the cHPI signals can be filtered out from the data being 
displayed.

On-line averaging can in principle be performed during a cHPI measure-
ment, but currently there are problems which limit its feasibility. The strong 
cHPI signals render artefact rejection almost useless and, with the limited 
time span available, filtering out the cHPI signals from the average is not as 
effective as with continuous data.

The cHPI data is post-processed using MaxFilter™ Software to extract the 
head position as a function of time and to remove the cHPI signals. MaxFil-
ter™ also provides an off-line averager similar to the on-line averager.

For details, see document MaxFilter™ User’s Guide. This system requires Max-
Filter™ release 2.2 or higher.
NM23732A-B1 Acquisition 33



DATA ACQUISITION
5.3. Raw data display (real-time display)

During acquisition the incoming data are displayed in a window positioned 
to the right of megacq by default.

The length of the displayed raw data segment can be set to various pre-
defined lengths. 

The name of each channel shown is indicated to the left of each trace. Verti-
cal lines are shown at a selectable spacing for time reference. The events 
detected on the stimulus input channels are also shown by yellow vertical 
lines if any of the stimulus input channels are selected to the display.
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5.3.1. Controls

The following controls are located at the bottom of the window:

1. Channel selection buttons.
When you press the left or right arrow buttons the display shows the 
previous or next set of channels, respectively. Channel selections are 
discussed in detail in Section 5.3.2.

2. Pause (||)
The raw data display is frozen, but the acquisition still continues. When 
the raw data display is frozen you can still move through the channels 
with the channel selection buttons.

3. Selection…
This button invokes a dialog showing the currently selected MEG chan-
nels in graphical form. The shortcut buttons to go to a desired selection 
are also located here.

4. Scales…
When you press this button a dialog appears to change the scales of 
various channel types and the spacing between vertical time markers.

5. Colors…
When you press this, a color definition dialog is shown to change the 
colors of the components of the display.

6. xy
An oscilloscope-like display for sensor tuning pops up with this button.

7. Window
An option menu for selecting the time span of the displayed raw data 
trace in seconds. The choices are 1, 3, 5, 8 and 10 seconds.
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5.3.2. Channel selections

When you press the Selection… button in the raw data display controls the 
window shown below appears.

The graphical display on the left indicates the currently selected channels. 
The buttons on the right list the available selections with descriptive 
names. There are two add-on selections available to include additional 
channels to each selection:
Fixed electric

The first two electric (BIO, EEG, EOG, EMG, or ECG) channels are shown 
after the currently selected channels.

Stimulus
Switch on/off displaying of stimulus trigger channels (signals labelled 
as STI...).

Show layout
The channel layout on the left can be hidden with this function to make 
the selection window smaller.

You can customize the standard selections in the following way:
1. Copy /neuro/dacq/setup/rawdisp.sel to the directory 

.meg_analysis under your home directory
cp /neuro/dacq/setup/rawdisp.sel ~/.meg_analysis/

2. Edit file ~/.meg_analysis/rawdisp.sel with a text editor.
Each line in this file corresponds to a selection. The format of each line 
is:
<selection name>:<ch name 1>|<ch name 2>|…
For example:
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My selection:MEG0111|MEG0112|MEG0113

The channel names are identical to those listed in the channel selection 
dialog, see Section 3.3. on page 11.

5.3.3. Scales

The vertical scales of the real-time display are fully configurable with the 
means of the Scales... dialog whereas the time span of the raw data display 
is determined by the window selection only. However, the time marks can 
be set to appear at user specified intervals by the Scales... dialog. The 
default scales can be configured by qualified service personnel.

Magnetometer and axial gradiometer channels typically require wider dis-
play scales than planar gradiometer channels. The axial sensor scale multi-
plier (Axial Multiplier) multiplies the MEG scale figure to set the vertical 
scale for axial gradiometer and magnetometer channels.

By default, raw data display subtracts the average signal amplitude calcu-
lated over the display time span from each sample thus keeping the signal 
traces on the display even when strong low frequency signal components 
are present. This behavior can be switched on and off by toggling Remove 
dc offset button. This affects only the display and not the raw data 
recorded to a file.
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If an on-line signal space projection operator (see Section 8) is used, the 
noise suppression for the display can be controlled by the Apply SSP but-
ton. Note that this does not have any effect on the raw data recording itself.

Use of display low-pass filtering can be controlled by the Lowpass filter
buttons. The low-pass corner frequency can also be specified. The low-pass 
filtering can be toggled on or off for each channel type individually.

Use of display notch filtering can be controlled by the Notch filter buttons. 
If turned on, the specified line frequency and its first two harmonics (e.g. 50 
Hz, 100 Hz, and 150 Hz) are filtered out. The notch filter can also be toggled 
on or off for each channel type individually.

5.3.4. XY display

The tuning of the SQUID sensors can be done without the tuner program 
by using the XY display incorporated in the raw data display. The XY display 
shows the signal from one channel at a time; the Y (vertical) deflection is 
driven by the output of the selected channel whereas the X (horizontal) 
deflection is driven by the excitation signal fed to the SQUIDs in the tune 
mode.

The XY display works in conjunction with the Squiddler program so that 
selecting a channel in Squiddler automatically selects the same channel 
for the XY display. In addition, the arrow buttons can be used to select any 
individual channel. You can also choose from three different scales.

Tuning is described in more detail in document Sensor Tuner User’s Manual.

Note: The XY display is functional only if you have selected the EXCI chan-
nel in the acquisition setup dialog. See Section 3.3. “Acquisition” on page 11.
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5.4. On-line averaging

5.4.1. Messages

As mentioned in Section 5.1, on-line averaging is switched on and off from 
the Average control button. The number of responses averaged into each 
category is listed on the third message line. If an epoch is rejected from the 
average, a message indicating this is displayed on the fourth message line. 
The Epoch rejected message will remain for a while even if subsequent 
epochs are again accepted. Reasons for the rejections (and the pertaining 
channels) are listed in the log message area at the top of the main control 
window.

5.4.2. Adjusting on-line averaging

You will notice that the on-line averaging setup button remains active even 
during acquisition. Therefore, you can change the on-line averaging param-
eters during acquisition. If you accept the changes, all existing averages are 
cleared and the averaging is started from beginning. Changes to the on-line 
averaging parameters do not affect the raw data collection.

5.4.3. Marking channels as “bad”

You can set channels to be ignored from the on-line artefact rejection pro-
cedure from the dialog that appears when you select Set bad channels…
from On-line menu. If some channels are causing rejections and you would 
like to continue without rectifying the problem, check the corresponding 
channels in the bad channels dialog. The ignored channels will be marked 
‘bad’ in the resulting evoked-response output files but their signals will 
nevertheless be present in both average and raw data files unlike those 
channels that are turned off.

5.4.4. On-line average display

During averaging, partial results are displayed at selectable intervals in the 
standard plotting program, xplotter, as discussed in Section 3.5.7. You can 
manipulate the display of responses (filtering, baselines, scales, etc.) in the 
xplotter window during acquisition.

If you would like to update the averages without waiting for the selected 
time interval to elapse, select Update average display from the On-line
menu. When you schedule a display update manually, the display update 
timer will be reset and the next update will be scheduled to occur after the 
regular interval from the manual display update.

5.4.5. Select displayed categories

The categories displayed on-line are initially selected from the averaging 
parameters dialog. You modify the selection of displayed categories and 
on-line display update rate from Select displayed categories... in the On-
line menu. The choices are kept between acquisitions, i.e., any changes 
made here are equivalent to modifying the standard averaging parameter 
dialog with the exception that the on-line averaging is not restarted from 
the beginning when you activate the changes from the OK button.

When on-line averaging completes, all categories averaged are always dis-
played, regardless of the currently active display selection.

If on-line averaging is not active, selecting displayed categories gives an 
error message.
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5.5. Raw data recording

While the measurement is running you can start recording raw data by 
using the Record raw button in the acquisition controls. If you switch 
recording on and off several times during one measurement, the separate 
segments of raw data will be concatenated into the same raw data file. 
Since all the segments will have time tags referring to the actual measure-
ment time, the different segments can be identified at the analysis phase.

When raw data is being recorded, the amount of data recorded as well as 
the amount of free disk space are displayed on the second message line of 
megacq.
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5.6. EEG impedance measurements

The acquisition system allows measurement of EEG electrode impedances. 
When electric (BIO, EEG, EOG, EMG, or ECG) channels have been activated, 
the EEG impedance display pops up automatically when a measurement is 
started.

The impedance measurement is started and stopped by clicking on the 
check-box at the left upper corner of the dialog. When the impedance mea-
surement is started EEG system starts feeding probe currents to the elec-
trodes and measures the resulting voltages. The amplitudes of the voltages 
are then converted to impedance values and shown on the dialog.

The display uses color coding to indicate the resistance as high = red, inter-
mediate = yellow, low = green, and unrecognized behavior is indicated in 
blue. By default, low resistance is below 5 kOhm for unipolar EEG channels 
and below 75 kOhm for the bipolar ones. High resistance is over 20 kOhm 
for unipolar EEG channels and over 100 kOhm for bipolar ones.

Note: Currents are fed to the electrodes during the impedance measure-
ment. This prevents making normal EEG measurements while the imped-
ance measurement is on.
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5.7. Stopping the acquisition

When you have collected the desired number of responses into the aver-
ages and you have collected all necessary raw data, press Stop to finish the 
acquisition. If on-line evoked-response averaging was requested, the save 
dialog for evoked-response data will appear automatically once all data 
have been processed. After the evoked-response data are stored, a dialog 
prompting for the raw data file name will appear if any raw data were col-
lected.

If you choose not to save either data, the system will emit a “last chance” 
message when starting a new measurement which would destroy these 
data.

See Section 6.2. “Saving averages and raw data” on page 43 for details 
about saving your data.
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6. SAVING DATA

6.1. Data volumes

Acquired data are saved to one of the predefined data volumes. Under the 
volume top level directory, the data files will be stored in

<project>/<last name>_<first name>/<date>,

if you are studying a volunteer, or

<project>/case_<id>/<date>

if your subject is a patient, as explained in Section 3.2.2.

If no subject name has been selected, the subject part of the path will be 
no_name.

The saving paths can be tailored according to local needs by MEGIN Cus-
tomer Care.

6.2. Saving averages and raw data

If any on-line averages were computed or raw data was recorded, a saving 
dialog appears automatically. The user is first prompted for saving aver-
ages, if any. In this case the dialog is titled Save evoked responses. The 
user is then prompted for saving raw data, if any. In this case the dialog is 
(re)titled Save raw data.

Saving is done in background. Therefore, you can continue with the next 
acquisition while saving of previously acquired raw data is still in progress. 
You can iconify the data saving window.

If the recorded raw data file size becomes larger than a predefined value (in 
normal configuration 2GB minus 100MB), the data file is closed and a new 
continuation file is created. The exact size of the file can vary somewhat 
depending on how the internal blocks exceed the limit. When this kind of a 
split measurement is saved, the first segment is given the name which user 
writes into the saving dialog. Rest of the segments have the same name 
with a dash and a running number appended (numbering starts from one).

6.3. The saving dialog

The saving dialog has the following components:

1.
2.

5.

6.

7.

4.

3.

8. 9. 10.
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1. An option menu to select the destination volume.
2. The root pathname of the selected volume and the amount of free 

space on the volume.
3. The destination directory for the data.
4. A text field to enter the destination file name. Use only letters, numbers 

and the underscore character in the file name. The suffix .fif is 
appended automatically.

5. A text field to enter a comment to go with the data.
6. Real and login name of the current user, which are saved with the data.
7. Status line indicating the state of saving.
8. Save button to start saving.
9. Stop button to interrupt saving.
10. Discard button to discard the averages or raw data.

6.4. Rescuing data after a crash

If you have collected data but megacq has ceased to work after you pressed 
Stop, you can rescue your data by selecting the Rescue Data icon in the 
Maintenance folder.

If there is data that can be saved, you will first see a confirmation dialog that 
you would really like to proceed, as shown below:

Thereafter, a standard megacq saving dialog (see Section 6.3) will appear. 
Note that the rescued data will be saved under the project directory called 
unknown if the real project name could not be retrieved.
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7. RESTARTING THE SOFTWARE

7.1. When to restart

The data acquisition may under some circumstances either stop prema-
turely or freeze with the following symptoms:
1. Megacq becomes non-responsive for a long time. When windows cov-

ering megacq are moved, the exposed areas are not repainted.
2. When megacq is started it fails to contact the data server.

Most common reasons for this are networking problems. You can recover 
the system by restarting the acquisition software modules.

If the front-end DSP boards hang up, a complete power cycle is not nor-
mally required. It is enough to stop the acquisition program (megacq), reset 
the DPS boards, and restart the acquisition program again. The DSP boards 
are reset by pressing the Reset button on the SCC board panel and waiting 
until all DSP boards boot-up to green Run-status.

7.2. Restarting procedure
1. Open the Maintenance folder under Neuromag folder in the desk-

top’s applications menu to see the available actions.
2. Select the Restart Acquisition Programs icon.
3. Confirm that you really want to proceed by answering y to the question 

appearing in the Restart Acquisition Programs terminal window.
4. Observe the messages in the window during the restarting. Should the 

restart operation fail, verify all physical power and data connections as 
well as network connections.

5. Wait until the message 
Restart complete. Press <Enter> to close the win-
dow

appears and press <Enter>.

6. If you had collected data and megacq ceased to work after you pressed 
Stop, you can rescue your data by double-clicking the Rescue Data
icon in the Maintenance folder.
If there is some data to be saved, you will first see a dialog to confirm 
that you would really like to proceed. Thereafter, a standard megacq
saving dialog (see Section 6.3) will appear. Note that the rescued data 
will be saved under the project directory called unknown if the real 
project name could not be retrieved.

7. Restart megacq by selecting the Acquisition icon in the Neuromag
folder.

8. If you have completed the HPI digitization, you will be given a chance 
to use the HPI data again. Alternatively, you can use Load preparation
in the File menu which allows quick restoration of the previous setup 
of the acquisition software.

9. Reload the SQUID tuning file (with Tuner) if the power-up tuning set-
tings are not optimal.
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8. USING SIGNAL SPACE PROJECTION

8.1. Background

External magnetic disturbances which have fairly uniform distribution but 
varying amplitudes can be suppressed by the signal space projection (SSP) 
technique.

The measured signals span a signal space whose dimension equals the 
number of channels n being measured. Thus, at each sampling point in 
time, the signals can be described as a vector in the signal space. For a given 
distribution or field topology the signal vector points to the same direction 
but its length varies as the amplitudes of the signals change. Once the dis-
tribution(s) corresponding to a disturbance are known a suppressing SSP 
operator can be constructed from the distributions. The operator projects 
each sample vector in the signal space so that the disturbance becomes 
orthogonal to the n-1 dimensional hyperplane in the signal space and thus 
disappears. The drawback is losing one degree of freedom, i.e., one inde-
pendent measurement, and the slight deformation of response patterns if 
viewed without a subsequent reconstruction.

Since the topology of external disturbances at a particular site is typically 
constant to a good approximation, it is not necessary to define the SSP 
operator individually for each measurement, if the magnetometer probe is 
at a fixed location and orientation. The system selects automatically the SSP 
operator from a predefined set of operators depending on the gantry posi-
tion and whether internal active shielding is being used.

The data are always stored intact, but the operator is included in the data 
files, so that various data viewers and analysis programs can take it into 
account, or at request, show the non-projected original data. Note however, 
that if MaxFilter™ is applied to the data files, it removes the SSP vectors from 
the resulting filtered data files, as the SSS processing (by MaxFilter™) and 
applying SSP vectors are complementary methods for artifact removal.

8.2. SSP and the on-line averager

Since averaging and projection are both linear operations and thus com-
mute, projection can also be done to the final average. The on-line averager 
attaches the SSP operator to the output average file but leaves the actual 
signal intact, i.e., un-projected. The visualization software is responsible for 
applying the SSP operator to the data.

The rejection checking of the on-line averager, however, uses SSP-filtered 
data.

8.3. Creating SSP operators

8.3.1. Locations of the SSP files

The SSP operator used by the system is defined in a FIFF file. Exactly which 
file is used depends on the gantry position angle (0 for supine, 60 for semi-
upright, 68 for upright), and whether Internal Active Shielding (IAS) is being 
used. The SSP operators are loaded from
/neuro/dacq/setup/ssp/online_0.fif, 
/neuro/dacq/setup/ssp/online_60.fif, or
/neuro/dacq/setup/ssp/online_68.fif,
when the system does not have IAS or it is turned off, or from
/neuro/dacq/setup/ssp/online_0_ias.fif, 
/neuro/dacq/setup/ssp/online_60_ias.fif, or
/neuro/dacq/setup/ssp/online_68_ias.fif,
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when IAS is turned on.

If that file does not exist or if it does not contain an SSP operator, the on-line 
SSP is silently turned off.

8.3.2. Pre-requisites

The following procedure requires Data Analysis software, which must be 
installed to the workstations where the SSP files are generated.

8.3.3. Procedure

1. Tune all the channels. Make a note of extremely noisy or nonfunctional 
channels.

2. Do a set of “empty room” measurements. Use 1000 Hz sampling fre-
quency, 330 Hz low-pass and 0.1 Hz high-pass filtering. Record raw data 
for about two minutes in all gantry positions (separately both with 
Internal Active Shielding turned off and on). Save the raw data files with 
names like empty_room_0.fif and empty_room_0_ias.fif, 
where the gantry angle 0 is replaced with 60 or 68 depending on the 
gantry position.

3. Start the Signal processor (graph) program. Load or create a Graph 
setup, which includes at least the ssp and pca packages in addition to 
the basic setup. These additional modules can be loaded by the lisp 
commands
(require "pca")

(require "ssp")

(require "std-selections")

Create and connect the widgets as follows (the type of the widget is in 
parenthesis and the name you should give to the widget is before the 
parenthesis):
file(diskfile) > buffer(ringbuffer) > meg(pick) >
ssp(suppressor) > pick(pick) > display(plotter)
Change the buffer size of ssp widget by double-clicking its icon: Enter 
20000 (the default is 2000, which is too low). Increase also the buffer 
size of the buffer widget to 1000000 to speed up the processing.

4. To calculate the SSP operator for gradiometers, change the names
resource of the meg widget to MEG* and ignore to MEG*1. This retains 
the original order of the gradiometer channels in the data file.
Open the raw data file
empty_room_0.fif

Add the bad channels, if any, as ignored channels so that they won't 
spread the noise to the good channels via the SSP. Use Selections
menu to display and browse through the channel sets of interest. You 
may want to enable the superpose function of the display widget for a 
better view.
Enter the lisp command
(pca-on-widget 'meg 0 120)

to calculate the principal components for the time span 0 …120 sec-
onds since the beginning of the file. Once the PCA calculation is com-
plete, select SSP dialog... from the Commands menu. In SSP dialog 
select Add PCA fields from the Actions menu, then select 8 vectors. 
You should get an entry like PCA[204,8] in the vector pool. Select it by 
clicking it and do Explode from the Edit menu. Now you can apply the 
vectors one at a time by first selecting the vector (start from PCA-v1 as 
it is the one corresponding to the largest singular value) and then click-
ing the right arrow, which copies the vector to the SSP vector panel. The 
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suppressor automatically turns on once there is at least one vector 
assigned for it. You should see a decreasing noise level on the display 
as you keep on adding vectors.
Once you have decided how many and which vectors you need, delete 
the rest ALSO from the vector pool! Then select Save from File menu 
and specify file name
/neuro/dacq/setup/ssp/grad_ssp_0.fif

Generally, 5 vectors for magnetometers seem to be enough in most 
cases, and 0 … 3 vectors for gradiometers. Using more vectors, of 
course, make the raw data look better but they unnecessarily attenuate 
brain signals as well and complicate analysis. So, do not use more vec-
tors than necessary. 
Select a short time span (less than one second) of raw data on the dis-
play with the right mouse button. Select Make evoked file from File
menu and specify file name
/neuro/dacq/setup/ssp/grad_names_0.fif

5. Open a terminal window. Do
cd /neuro/dacq/setup/ssp

/neuro/bin/util/add_proj_namelist -f  
grad_names_0.fif grad_ssp_0.fif

This operation adds the channel names to the SSP vectors. The second 
command is a single command line, though it is here divided on two 
line.

6. You may now repeat steps 4. and 5. for magnetometers. Of course, 
delete the previous SSP vectors both from the pool and SSP panels. Set 
names resource of the meg widget to MEG*1 and remove MEG*1 from 
ignore before doing the PCA for the magnetometers. Save the results 
to files
/neuro/dacq/setup/ssp/mag_ssp_0.fif

/neuro/dacq/setup/ssp/mag_names_0.fif

7. Combine the gradiometer and magnetometer SSP operators in the 
Source modelling program (xfit).
Open an evoked response file which has data from all channels (both 
magnetometers and gradiometers if you are going to do the operator 
for both types of sensors.) Open the Projection window and use Load
in File menu to load your newly created
/neuro/dacq/setup/ssp/grad_ssp_0.fif

and
/neuro/dacq/setup/ssp/mag_ssp_0.fif

Check the Allow measurement ID mismatch before loading the 
above files.
Select all the SSP vectors in the projection list. Select Save from File
menu and specify file name
/neuro/dacq/setup/ssp/online_0.fif

8. Change the file permissions
cd /neuro/dacq/setup/ssp

chmod 644 online_0.fif

9. Test the new SSP operator by starting the acquisition such that the gan-
try angle and the IAS state match the file created in step 7. Checking the 
signals on the raw data display with the Apply SSP button in the Scales
window on and off. If the button is insensitive (i.e. you cannot click it), 
the SSP vectors were not found or were unreadable.

10. Repeat the steps 4. through 9. with the raw data file 
empty_room_0_ias (same gantry position and IAS turned on). 
Remember to replace _0 with _0_ias also in the other file names.

11. Repeat the steps 4. through 10. with the raw data from the other gantry 
positions. Remember to replace the gantry angle 0 with 60 for semi-
upright and 68 for upright in the file names.
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9. PHANTOM MEASUREMENT

9.1. Introduction

The basic operation of the system is typically easily verified by running a 
phantom test. The default configuration of the Data Acquisition Software 
Release 6.0 includes phantom test setup files for standard Phantom (Art. no. 
NM24058N). If another phantom is used, the process may be customized 
for the particularities with the instructions in Section 9.5.

The automated phantom protocol switches on the dipoles inside the phan-
tom sequentially and records the resulting signal. The resulting file must 
then be analyzed to establish that the system has functioned as expected. 
This chapter does not discuss the details of this analysis, see e.g. documents
TRIUX User’s Manual or TRIUX™ neo Instructions for Use for full details.

The automated phantom protocol can be used for the following two pur-
poses: (1) verifying the operation of the full system, or (2) verifying the 
operation of the magnetometer probe only.

9.2. Phantom control tool user interface

The user interface parts are shown and described below:

The dialog contains the following items:
1. Buttons for loading the measurement settings for the phantom proto-

col, and loading up a pre-digitization of the phantom head.
2. Text fields for specifying the dipole amplitude and the starting dipole 

of the sequence.
3. A checkbox for selecting automatic dipole changing sequence or no 

sequence (one individual dipole activated only).
4. Activate and deactivate buttons for the dipole operation.
5. A message line containing the phantom’s current status.
6. A close button for closing the phantom control dialog.

9.3. Procedure for system verification
1. Start the Acquisition control software from Neuromag folder in the 

desktop’s applications menu.
2. Select a suitable project (e.g. Verification tests).
3. Select a suitable subject (e.g. Phantom)

1.

2.

3.

4.

5.

6.
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4. Select Phantom... in the Tools menu.
5. Click on Load settings in the phantom control tool.
6. Verify that the amplitude is the desired (the default 1000 nAm pp is 

used in the Phantom test protocol)
7. Select Change in the acquisition control software to start and perform 

the head digitization in a normal fashion. Finally close the head digiti-
zation.

8. Click on GO! to start measuring.
9. Click on Measure in the HPI measurement dialog.
10. Check the HPI coil locations in the HPI results dialog and, if the HPI fit-

ting was successful, click on Accept and proceed to next step. Other-
wise click on Try again and redo this step.

11. Back at the phantom control tool, specify the first dipole to fire, if 1 is 
not suitable.

12. Select Activate sequentially.
13. Click on Activate.
14. Select Average in the acquisition control software.
15. Observe the progress of the phantom measurement in signal trace 

curves in the raw data display window and also the averaging progress 
on the acquisition control software’s status lines.

16. The phantom measurement deactivates automatically at the end of the 
defined sequence, or you can click on Deactivate to stop it prema-
turely.

17. Click on Stop in the acquisition control software.
18. Save the resulting files to a suitable location.
19. Analyze the resulting files according to the phantom analysis instruc-

tions given in TRIUX User’s Manual or in TRIUX™ neo Instructions for Use.

9.4. Procedure for probe verification

Follow the procedure described above for full system verification otherwise 
but at step 5, also click on Load digitization in the phantom control tool. 
Also skip step 7, the head digitization, altogether. This way you will use the 
pre-made digitization files and are able to quickly determine the function-
ing of the magnetometer probe.

9.5. Customizing the phantom measurement

The measurement settings for a phantom measurement are loaded from 
phantom.set file in /neuro/dacq/setup/phantom. The head digiti-
zation file is loaded from phantom.iso in the same directory. These two 
files can be modified to adapt the phantom sequence to the phantom hard-
ware used.

The phantom.set file contains a subset of the settings found in a stan-
dard settings file saved with acquisition control software’s Save settings 
feature. Only the settings beginning with ERF prefix from such a regular set-
tings file should be included in the phantom.set file.

The head digitization file is easily created by digitizing the phantom in a 
normal fashion and then copying the resulting digitization file from /
neuro/dacq/meas_info into /neuro/dacq/setup/phantom
directory and then re-linking the phantom.iso symbolic link to point to 
this digitization file.

Depending on your phantom hardware you should also set the phantomCal
value in /neuro/dacq/setup/collector/conf/collec-
tor.defs. See the commentary in that file for details on how to deter-
mine this value.
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APPENDIX A Error messages

This appendix gives descriptions for the error messages that can be 
expected to be delivered by the software. It is possible that other messages 
are also given if there are design errors or the software is otherwise brought 
to a state that is not anticipated by the designers. Please consider contact-
ing MEGIN Customer Care if such error messages occur.

The messages are given in two tables below. The first one provides the error 
messages given by the data acquisition control module. The second one 
provides the errors messages produced by the measurement front end. The 
messages in the latter ones are often referenced in the messages given in 
the first table.

Variable parts of the messages are denoted by text enclosed by < and > 
characters. For example <number> means, that there is some number in the 
message at this point. The menu and dialog items are separated by > char-
acters. For example menu entry File > Save settings means Save settings -
button in the File menu.
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Actions

xpectedly. 
s number 
he reason 
 errors 
d has hap-

If the error repeats, please contact MEGIN Cus-
tomer Care.

urpose or 
=' is the 
ignal 

as termi-
mething 

If the unexpected termination repeats, please 
contact MEGIN Customer Care.

xpectedly. 
s number 
he reason 
 errors 
d has hap-

If the error repeats, please contact MEGIN Cus-
tomer Care.

e compo- Please restart the acquisition system.

e compo- Please restart the acquisition system.

Check that collector is running.

Check that collector is running.

onse. Contact MEGIN Customer Care.

 Stop the measurement and try to start it again. 
Please contact MEGIN Customer Care if this 
error repeats.
Table 1: 

Context Error message Description

Any time <program_name> (pid = <number>) died due to 
signal <number>) [core dumped]

A software component has stopped une
The <number> after 'pid =' is the proces
in the system and the signal number is t
why the program was terminated. These
usually mean that something unexpecte
pened. 

Any time <program_name> (pid = <number>) terminated 
with <number>.

A software component has stopped on p
unexpectedly. The <number> after 'pid 
process number in the system and the s
number is the reason why the program w
nated. These errors usually mean that so
unexpected has happened. 

Any time <program_name> (pid = <number>) terminated 
unexpectedly

A software component has stopped une
The <number> after 'pid =' is the proces
in the system and the signal number is t
why the program was terminated. These
usually mean that something unexpecte
pened. 

Any time Tried to send to a closed connection System is not up properly, some softwar
nents are not running. 

Any time Collector not connected! System is not up properly, some softwar
nents are not running.

Any time Collector conversation failed: <error>! Collector communication failed. 

Any time Get collector status command failed: <error> Collector communication failed.

Any time Could not get collector status: <error> Collector returned an invalid status resp

Any time xplotter command <command> failed in <con-
text>: <error>

Xplotter communication failed.
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Please contact the local administrator.

cquisition Please contact MEGIN Customer Care to obtain 
necessary licenses.

d. Please contact MEGIN Customer Care.

Please contact MEGIN Customer Care.

tem. Please contact MEGIN Customer Care.

tem. Please contact MEGIN Customer Care.

d. Please contact MEGIN Customer Care.

tem Please contact MEGIN Customer Care.

y not been Restart acquisition programs. If this does not 
help, please contact MEGIN Customer Care.

tem. Please contact MEGIN Customer Care.

tem. Please contact MEGIN Customer Care.

tor com-
figuration 
n be 

Restart acquisition programs. If this does not 
help, reboot the workstation. If this does not 
help, please contact MEGIN Customer Care.

d or miss-
 error 

e.

Restart acquisition programs. If this does not 
help, reboot the workstation. If this does not 
help, please contact MEGIN Customer Care.

 data. Check that /neuro/dacq/meas_info does not 
contain file isotrak that is owned by some 
unexpected owner.

Please contact MEGIN Customer Care.

Please contact MEGIN Customer Care.

Actions
Starting acquisition program Opening <path>/licenses.neuromag: <system 
error>

License file cannot be loaded.

Starting acquisition program There is no license for you. Sorry. There is no license to run this version of a
program. 

Starting acquisition program <name>.vars: <system error> Variable definitions file cannot be loade

Starting acquisition program <name>.defs: <system error> Variable settings file cannot be loaded.

Starting acquisition program NM_DEVICE is not set Internal error in configuration of the sys

Starting acquisition program NM_DEVICE is unknown: <device_name> Internal error in configuration of the sys

Starting acquisition program <path>/prepared/index: <system_error> Preparations database cannot be update

Starting acquisition program Could not get collector host. Internal error in configuration of the sys

Starting acquisition program Could not contact collector. The front end of the system has probabl
started or has terminated.

Starting acquisition program Could not login to collector. Internal error in configuration of the sys

Starting acquisition program Could not connect to data server! Internal error in configuration of the sys

Starting acquisition program Could not initialize acquisition. Possible reasons: out of resources, collec
munication failed, invalid or missing con
variable. More detailed error message ca
found in megacq.log file.

Starting acquisition program Could not initialize averaging. Possible reasons: out of resources, invali
ing configuration variable. More detailed
message can be found in megacq.log fil

Starting acquisition program Could not read Isotrak: <error> Internal error. Cannot access digitization

Main window > Change 
project

<path>/projects/index: <system error> Projects database cannot be loaded.

Main window > Change sub-
ject button

<path>/subjects/index: <system error> Subjects database cannot be loaded.

Table 1: 

Context Error message Description
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cording to 
e this 
 become 

Either do not change the EEG settings or redo 
the digitization.

Please contact MEGIN Customer Care.

Please contact MEGIN Customer Care.

Check that collector is running.

Check that all cables are connected. Contact 
MEGIN Customer Care.

ve the Please select a project and then retry.

ated. 
sources.

Check that the disk is not full.

eated. 
sources.

Check that the disk is not full.

ated. 
sources.

Check that the disk is not full.

ated. 
sources.

Check that the disk is not full.

ted. 
sources.

Check that the disk is not full.

d. Please contact MEGIN Customer Care.

he set- Please select a project and then retry.

Please contact MEGIN Customer Care.

Actions
Main window > Change 
acquisition

Changing the states of the electric channels may 
invalidate the digitization of the EEG electrode 
locations.

Digitization of the electrodes is made ac
the EEG channel selections. If you chang
setup after digitization, the settings may
incompatible with the digitization!

Main window > Change HPI 
button

Isotrak hemisphere definition variable not set! System configuration is invalid.

Main window > Change HPI 
button

Illegal Isotrak hemisphere definition: <HEMI> System has invalid configuration.

Main window > Change gan-
try button

Get gantry position command failed: <error> Collector communication failed.

Main window > Change gan-
try button

Could not get gantry position: <response> Collector returned an error response.

Menu 'File > Save prepara-
tion

'Please select project first. Preparations are stored per project. To sa
preparation some project must be set.

Menu 'File > Save prepara-
tion

'<name>.set: <system error> The contained settings file cannot be cre
Invalid system configuration or out of re

Menu 'File > Save prepara-
tion

'<name>.sti: <system error> The contained stimulus file cannot be cr
Invalid system configuration or out of re

Menu 'File > Save prepara-
tion

'Could not store project data (status=<exit 
code>).

The contained project file cannot be cre
Invalid system configuration or out of re

Menu 'File > Save prepara-
tion

'Could not store subject data (status=<exit 
code>).

The contained subject file cannot be cre
Invalid system configuration or out of re

Menu 'File > Save prepara-
tion

'Could not store Isotrak data (status=<exit 
code>).

The contained isotrak file cannot be crea
Invalid system configuration or out of re

Menu 'File > Save prepara-
tion

'<path>/prepared/index: <system error> Preparations database cannot be update

Menu 'File > Load settings 'Please select project first. Settings are stored per project. To save t
tings, some project must be set.

Menu 'File > Load settings '<path>/settings/index: <system error> Settings database cannot be loaded.

Table 1: 

Context Error message Description
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entries for If no settings have been saved so far, you can 
ignore this message. Otherwise contact MEGIN 
Customer Care.

. Please contact MEGIN Customer Care.

 any If no preparations have been saved so far, you 
can ignore this message. Otherwise contact 
MEGIN Customer Care.

ettings, Please select a project and then retry.

en saved. Please wait for savers to complete (or cancel 
them).

fficially Do not use this software for clinical purposes.

Stop the measurement and try to start it again. 
Please contact MEGIN Customer Care if this 
error repeats.

hilst Stop the measurement and load the new set-
tings.

Select preparation to be loaded.

ded. The 
ovides 
reason.

Check that the preparation file exists and is 
readable by you.

imulus file. Please contact MEGIN Customer Care.

aded. Check that the directory /neuro/dacq/settings 
exists and is readable by you.

Please contact MEGIN Customer Care.

ded. Check that the file exists and is readable by you.

g. Please contact MEGIN Customer Care.

ded. Please contact MEGIN Customer Care.

Actions
Menu 'File > Load settings 'No settings available [for this project] Settings database does not contain any 
current project.

Menu 'File > Load prepara-
tions

'<path>/prepared/index: <system error> Preparations database cannot be loaded

Menu 'File > Load prepara-
tions

'No normal preparations available Preparations database does not contain
entries.

Menu 'File > Save settings 'Please select project first. Settings are stored per project. To load s
some project must be set.

Menu 'File > Quit There are <number> files being saved in back-
ground. Cannot quit yet!

Some measurement data has not yet be

Menu 'Help > On version 'Warning! This is a beta-test version of the data 
acquisition...

This acquisition program has not been o
released.

Menu 'Online > Update aver-
age display

'to_averager: <error> Averager communication failed.

Load preparations dialog Cannot load preparation when measurement is 
running.

Cannot change measurement settings w
measurement is running.

Load preparations dialog Nothing selected Selection field is empty.

Load preparations dialog <name>.set: <system error> The contained settings file cannot be loa
system error message <system error> pr
more information about the underlying 

Load preparations dialog Cannot get stimuli file from variable. Settings file does not contain name of st

Load preparations dialog <name>.sti: <system error> The contained stimulus file cannot be lo

Load preparations dialog Illegal data in stimulus file! Stimulus file is of wrong format.

Load preparations dialog <name>.proj: <system error> The contained project file cannot be loa

Load preparations dialog No project id in <name>.proj Project file does not contain project id ta

Load preparations dialog <name>.subj: <system error> The contained subject file cannot be loa

Table 1: 
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ag. Please contact MEGIN Customer Care.

determine Please contact MEGIN Customer Care.

ed. Check that the file exists and is readable by you.

mation. Please contact MEGIN Customer Care.

not be Please contact MEGIN Customer Care.

not be Please contact MEGIN Customer Care.

Select settings to be loaded.

Check that the file exists and is readable by you.

imulus file. Please contact MEGIN Customer Care.

Check that the file exists and is readable by you.

Please contact MEGIN Customer Care.

Select settings to be deleted.

Check that the file exists and is writable by you.

y entries Informative, not actions needed.

Enter the name of the settings file.

stem con- Check that the directory /neuro/dacq/settings 
exists and is writable by you.

ystem con- Check that the directory /neuro/dacq/settings 
exists and is writable by you.

Check that the directory /neuro/dacq/settings 
exists and is writable by you. Check that the 
index is writable.

Actions
Load preparations dialog No subject id in <name>.subj Subject file does not contain subject id t

Load preparations dialog Subject mode cannot be determined Subject file attributes cannot be used to 
whether subject is patient or volunteer.

Load preparations dialog Could not restore Isotrak data (status=<exit 
code>)

The contained isotrak file cannot be load

Load preparations dialog Could not read Isotrak: <error> Isotrak file does not contain isotrak infor

Load preparations dialog Could not restore hpi_meas data (status=<exit 
code>)

The contained HPI measurement file can
loaded

Load preparations dialog Could not restore hpi_result data (status=<exit 
code>)

The contained HPI measurement file can
loaded

Load settings dialog > Apply Nothing selected Selection field is empty.

Load settings dialog > Apply <name>.set: <system error> Settings file cannot be loaded.

Load settings dialog > Apply Cannot get stimuli file from variable. Settings file does not contain name of st

Load settings dialog > Apply <name>.sti: <system error> Stimulus file cannot be loaded.

Load settings dialog > Apply Illegal data in stimulus file! Stimulus file is of wrong format.

Load settings dialog > 
Delete

Nothing selected Selection field is empty.

Load settings dialog > 
Delete

<path>/settings/index: <system error> Settings database cannot be updated.

Load settings dialog > 
Delete

No settings available [for this project] Settings database no longer contains an
for current project.

Save settings dialog > Save Settings name is empty. Name field is empty.

Save settings dialog > Save <name>.set: <system error> Settings file cannot be created. Invalid sy
figuration or out of resources.

Save settings dialog > Save <name>.sti: <system error> Stimulus file cannot be created. Invalid s
figuration or out of resources.

Save settings dialog > Save <path>/settings/index: <system error> Settings database cannot be updated.

Table 1: 
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Enter the name of a data file.

sting Enter name of a proper data file.

Check that the file exists and is readable by you.

g. Please contact MEGIN Customer Care.

d. Invalid 
.

Check that the directory /neuro/dacq/settings 
exists and is writable by you.

imulus file. Please contact MEGIN Customer Care.

d. Invalid 
.

Check that the directory /neuro/dacq/settings 
exists and is writable by you.

Please contact MEGIN Customer Care.

ted. 
sources.

Check that the directory <path>/tmp exists 
and is writable by you.

Stop the measurement and try to start it again. 
Please contact MEGIN Customer Care if this 
error repeats.

ted. 
sources.

Check that the directory <path>/tmp exists 
and is writable by you.

Stop the measurement and try to start it again. 
Please contact MEGIN Customer Care if this 
error repeats.

Check that the file exists and is readable by you.

Please enter a valid amplitude

Actions
Load measurement settings 
dialog > OK

Load file not specified. Selection field is empty or ends with '/'.

Load measurement settings 
dialog > OK

Selection is <not valid | a directory | a special 
file>.

Selection field should contain a valid exi
filename.

Load measurement settings 
dialog > OK

<name>.fif: <system error> Selected file cannot be loaded.

Load measurement settings 
dialog > OK

No settings available here Selected file does not contain settings ta

Load measurement settings 
dialog > OK

<name>.set: <system error> Temporary settings file cannot be create
system configuration or out of resources

Load measurement settings 
dialog > OK

Cannot get stimuli file from variable. Settings file does not contain name of st

Load measurement settings 
dialog > OK

<name>.sti: <system error> Temporary stimulus file cannot be create
system configuration or out of resources

Load measurement settings 
dialog > OK

Illegal data in stimulus file! Stimulus file is of wrong format.

Set bad channels dialog > 
OK

<path>/tmp/erf.evp: <system error> Averaging parameter file cannot be crea
Invalid system configuration or out of re

Set bad channels dialog > 
OK

to_averager: <error> Averager communication failed.

Select categories dialog > 
OK

<path>/tmp/erf.evp: <system error> Averaging parameter file cannot be crea
Invalid system configuration or out of re

Select categories dialog > 
OK

to_averager: <error> Averager communication failed.

Phantom dialog > Load set-
tings

<path>/phantom/phantom.set: <system error> Phantom settings file cannot be loaded.

Phantom dialog > Load digi-
tization

Could not restore Isotrak data (status=<exit 
code>)

Phantom isotrak file cannot be loaded.

Table 1: 
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mation. Please enter a valid amplitude

Please enter a valid amplitude

Please enter a valid amplitude

Please enter a valid dipole number

Please enter a valid amplitude

Check that collector is running.

Please enter a valid amplitude

Check that collector is running.

Please enter a valid amplitude

Check that the file exists and is readable by you.

ected for Check that the project name is correct.

stem con- Please contact MEGIN Customer Care.

Check that the file exists and is writable by you.

Check that the file exists and is writable by you.

Please contact MEGIN Customer Care.

determine Please contact MEGIN Customer Care.

Check that the file exists and is readable by you.

ected for Check that the subject name is correct.

Actions
Phantom dialog > Load digi-
tization

Could not read Isotrak: <error> Isotrak file does not contain isotrak infor

Phantom dialog > Activate Amplitude is not a valid floating point value! Invalid value was given.

Phantom dialog > Activate Amplitude is not in range 5.0 .. 10000.0! Invalid value was given.

Phantom dialog > Activate Dipole number is not a valid integer value! Invalid value was given.

Phantom dialog > Activate Dipole number is not in range 1 .. 32! Invalid value was given.

Phantom dialog > Activate Send activate phantom failed: <error> Collector communication failed.

Phantom dialog > Activate Bad activate phantom response: <response> Collector returned an error response.

Phantom dialog > Deacti-
vate or Close

Send deactivate phantom failed: <error> Collector communication failed.

Phantom dialog > Deacti-
vate or Close

Bad deactivate phantom response: <response> Collector returned an error response.

Project dialog > Existing 
project selected

<name>.proj: <system error> Project file cannot be loaded.

Project dialog > OK Current project is not valid Error occurred when this project was sel
editing.

Project dialog > OK <name>.proj: <system error> Project file cannot be created. Invalid sy
figuration or out of resources.

Project dialog > OK <path>/projects/index: <system error> Projects database cannot be updated.

Subject dialog > Subject 
type selected

<path>/subjects/index: <system error> Subjects database cannot be loaded.

Subject dialog > Existing 
subject selected

stat: <system error> Subject file does not exist.

Subject dialog > Existing 
subject selected

Subject mode cannot be determined Subject file attributes cannot be used to 
whether subject is patient or volunteer.

Subject dialog > Existing 
subject selected

<name>.subj: <system error> Subject file cannot be loaded.

Subject dialog > OK Current subject is not valid Error occurred when this subject was sel
editing.

Table 1: 
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ited to Check that the birth date is correct.

a valid one. Check that the birth date is correct.

lid date. Check that the birth date is correct.

nable, Check that the birth date is correct.

stem con- Check that the directory /neuro/databases/
subjects exists and is writable by you.

Check that the file exists and is writable by you.

fter this If usage of external stimulus is intentional, no 
actions are needed. Otherwise change the 
stimulus kind to 'Internal' and load the stimulus 
settings again.

Please enter the name of the stimulus file.

sting Please enter name of a valid stimulus file.

Check that the file exists and is readable by you.

Please enter name of a valid stimulus file.

fter this Change stimulus kind back to 'Internal' and try 
to save again.

Please enter the name of the stimulus file.

name. Please enter name of a valid stimulus file.

ion denied Check that the directory /neuro/dacq/stim 
exists and is writable by you.

ted. 
sources.

Check that the disk is not full.

Stop the measurement and try to start it again. 
Please contact MEGIN Customer Care if this 
error repeats.

Actions
Subject dialog > OK We can study only persons born in or after year 
1900

For technical reasons the birth date is lim
years after 1900.

Subject dialog > OK There are only 12 months in a year! The month value is invalid. Please enter 

Subject dialog > OK Illegal day of month! The day value is invalid. Please enter a va

Subject dialog > OK Julian date is too big! This error can occur if the date is unreaso
very long in the future or the past.

Subject dialog > OK <name>.subj: <system error> Subject file cannot be created. Invalid sy
figuration or out of resources.

Subject dialog > OK <path>/subjects/index: <system error> Subjects database cannot be updated.

Stimulus load dialog > OK Internal stimulus not selected. Stimulus kind was changed to External a
dialog was launched.

Stimulus load dialog > OK Load file not specified. Selection field is empty or ends with '/'.

Stimulus load dialog > OK Selection is <not valid | a directory | a special 
file>.

Selection field should contain a valid exi
filename.

Stimulus load dialog > OK <name>.sti: <system error> Stimulus file cannot be loaded.

Stimulus load dialog > OK Illegal data in stimulus file! Stimulus file is of wrong format.

Stimulus save dialog > OK Internal stimulus not selected. Stimulus kind was changed to External a
dialog was launched.

Stimulus save dialog > OK Save file not specified. Selection field is empty or ends with '/'.

Stimulus save dialog > OK Selection is <not valid | a directory | a special 
file>.

Selection field should contain a valid file

Stimulus save dialog > OK <name>.sti: <system error> Stimulus file cannot be created. Permiss
or out of resources.

Averaging editor > OK <path>/tmp/erf.evp: <system error> Averaging parameter file cannot be crea
Invalid system configuration or out of re

Averaging editor > OK to_averager: <error> Averager communication failed.

Table 1: 
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Informative, no actions needed.

. Please contact MEGIN Customer Care.

mation.

t is block- Please wait until evoked responses file and all 
raw data files from the previous measurement 
have been handed over to a saver program.

t is block- Please wait until evoked responses file and all 
raw data files from the previous measurement 
have been handed over to a saver program.

t is block- Please wait until evoked responses file and all 
raw data files from the previous measurement 
have been handed over to a saver program.

 the 
nt can be 

Please select a project and then retry.

channels Please select some channels and then retry.

Check that collector is running.

Check that all cables are connected. Contact 
MEGIN Customer Care.

ated. 
sources.    

Check that the disk is not full.

eated. 
sources.

Check that the disk is not full.

ated. 
sources.

Check that the disk is not full.

ated. 
sources.

Check that the disk is not full.

Actions
Digitizing Head digitization was cancelled. Digitization was cancelled.

Digitizing Could not restore Isotrak data (status=<exit 
code>)

The created isotrak file cannot be loaded

Digitizing Could not read Isotrak: <error> Isotrak file does not contain isotrak infor

Starting measurement Data saving is pending, waiting for timeout Saving data from previous measuremen
ing the start of a new measurement.

Starting measurement Data saving is pending, waiting for evoked! Saving data from previous measuremen
ing the start of a new measurement.

Starting measurement Data saving is pending, waiting for raw data! Saving data from previous measuremen
ing the start of a new measurement.

Starting measurement Project name undefined! Many operations are project related, and
project must be set before a measureme
performed.

Starting measurement No selected channels! Cannot make a measurement where no 
are measured.

Starting measurement Get gantry position command failed: <error> Collector communication failed.

Starting measurement Could not get gantry position: <response> Collector returned an error response.

Starting measurement <name>.set: <system error> The contained settings file cannot be cre
Invalid system configuration or out of re

Starting measurement <name>.sti: <system error> The contained Stimulus file cannot be cr
Invalid system configuration or out of re

Starting measurement Could not store project data (status=<exit 
code>).

The contained project file cannot be cre
Invalid system configuration or out of re

Starting measurement Could not store subject data (status=<exit 
code>).

The contained subject file cannot be cre
Invalid system configuration or out of re

Table 1: 
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ted. 
sources.

Check that the disk is not full.

d. Check that /neuro/dacq/prepared/index is 
accessible.

ot config- Reboot the system. If the error repeats, please 
contact MEGIN Customer Care.

Please stop the tuner first and then start the 
measurement.

o start 
re is some 

Stop any tools making measurements.

ector. Check that collector is running.

ollector. Check that collector is running.

ables the 
missing.

Check that all acquisition hardware compo-
nents are up and running.

Check that collector is running.

Please restart the acquisition software. If prob-
lem continues, contact MEGIN Customer Care.

tion data. Please contact MEGIN Customer Care.

. Please contact MEGIN Customer Care.

Please restart the acquisition software. If prob-
lem continues, contact MEGIN Customer Care.

ted. 
sources.

Check that the directory <path>/tmp exists 
and is writable by you, or that the disk is not 
full.

ponent Stop the measurement and try to start it again. 
Please contact MEGIN Customer Care if this 
error repeats.

response 

Actions
Starting measurement Could not store Isotrak data (status=<exit code>). The contained isotrak file cannot be crea
Invalid system configuration or out of re

Starting measurement <path>/prepared/index: <system error> Preparations database cannot be update

Starting measurement <ftok | semget>: <system error> Internal system error. Semaphores are n
ured properly. 

Starting measurement Tuning in progress! Tuner is running.

Starting measurement Previous measurement is still running! A measurement is running while trying t
new one. This probably indicates that the
external measurement tool being used..

Starting measurement Could not set up parameters! Could not send parameter values to coll

Starting measurement Could not set up stimuli! Could not send stimulus sequences to c

Starting measurement Could not set up collector completely! Some 
functionality is missing.

Collector setup failed in manner that en
system to run, but some functionality is 

Starting measurement Could not set up data collector! Could not setup collector.

Starting measurement The old HPI program is still running. System is in unexpected state.

Starting measurement Cannot do HPI : No HPI coils in Isotrak file! Internal system error. Corrupted digitiza

Starting measurement Cannot do HPI : failed to find out DAC amplitude! Invalid or missing configuration variable

Starting measurement The old averager program is still running. System is in unexpected state. 

Starting measurement <path>/tmp/erf.evp: <system error> Averaging parameter file cannot be crea
Invalid system configuration or out of re

Starting measurement Timeout when waiting for the started programs 
to get connected to the data server.

Internal system error: some program com
failed to start or was too slow. 

Starting measurement Measurement could not be started: <response> Measurement could not be started. The 
details the reason.

Table 1: 
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ment is Informative, not actions needed.

Table Col-  See Table Collector errors for details.

 HPI pro- Stop the measurement and try to start it again. 
Please contact MEGIN Customer Care if this 
error repeats.

Stop the measurement and try to start it again. 
Please contact MEGIN Customer Care if this 
error repeats.

. Please contact MEGIN Customer Care.

tion status 
rly recog-

Check that STI201 has been included in meas-
urement, trigger configurations, and the trig-
ger box connections.

nals leav-
r.

Reset channels, if not sufficient check MSR door 
closure, noise levels and correct problems.

liably. Check coil cabling, coil positioning within hel-
met and feed-through boards in the cabinet. 
Retry.

liably. Check coil cabling, and coil positioning within 
helmet. Retry.

inguished Check coil cabling, EEG rack connections, and 
coil positioning within helmet. Retry.

 not be 
nd noise.

Check coil cabling, and coil positioning within 
helmet. If only one is weak, you can continue 
with others.

d HPI coils Check coil cabling, and coil positioning within 
helmet. Retry.

ion of the Check coil cabling and coil positioning within 
helmet. Retry.

Actions
During measurement Only <number MB of space remaining. Measure-
ment will soon stop automatically.

Disk space has run out and the measure
stopped automatically.

During measurement <Collector error message> Collector generated error message. See 
lector errors for details.

Starting HPI measurement HPI was not properly started or died unexpect-
edly!

Cannot start HPI measurement because
gram is not running.

Starting HPI measurement to_hpi: <error> HPI communication failed.

Starting HPI fitting Cannot do HPI fit: <variable> not specified! Invalid or missing configuration variable

HPI measurement error: Timed out when waiting for trigger The trigger channel indicating HPI activa
was not found or the status is not prope
nized.

HPI measurement error: Too many vectors in the new subspace! The SSP operator removed almost all sig
ing too few to do calculations any furthe

HPI measurement error: Failure in detecting signals! (Details: ampli-
tude fitting failed)

HPI coil signals could not be detected re

HPI measurement error: Weak HPI coil signals. (Details: poor correla-
tions)

HPI coil signals could not be detected re

HPI measurement error: No sufficient signal in any coil! Check 
cabling.

None of the HPI coil signals could be dist
reliably from the background noise.

HPI measurement error: Some coil signals are weak. One or more of the HPI coil signals could
distinguished reliably from the backgrou

HPI measurement error: Not enough good coils At least three sufficiently reliably detecte
are needed for position detection.

HPI measurement error: Adjusting weights failed for coil 
<NUMBER>.

Too few sensors contribute to the detect
indicated HPI coil.

Table 1: 
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ion of the Check coil positioning within helmet. Avoid 
being outside of the helmet closure volume, 
but also avoid being too close to the helmet 
plastic. Continue, if results are otherwise good 
for all other coils, or retry.

m param- Please contact MEGIN Customer Care.

Check the HPI coils are connected to the side 
panel and that none of the wires is broken.

Check the cabling.

Please contact MEGIN Customer Care.

Please contact MEGIN Customer Care.

Try redoing the HPI measurement. If the meas-
urement fails systematically, please contact 
MEGIN Customer Care.

 is not Please contact MEGIN Customer Care.

esults file Please contact MEGIN Customer Care.

e. Redo the measurement. If it still fails, check that 
the MEG channels are giving proper signal, that 
the HPI coils are in proper places and that the 
coil cables are not broken. 

e. Redo the measurement. If it still fails, check that 
the MEG channels are giving proper signal, that 
the HPI coils are in proper places and that the 
coil cables are not broken. 

Actions
HPI measurement error: Adjust: Only <NUMBER> signals larger than 
limit, problems are expected!

Too few sensors contribute to the detect
indicated HPI coil.

Showing HPI results error: hpifit (pid=<number>) exited with code 1: 
Bad parameters

HPI fit encountered an unexpected syste
eter.

Showing HPI results error: hpifit (pid=<number>) exited with code 2: 
Bad HPI amplitudes. Maybe some coils are broken

No sufficient signal in any coil.

Showing HPI results error: hpifit (pid=<number>) exited with code 3: 
Bad coil order. Check the coil connections

Automatic matching of coils failed.

Showing HPI results error: hpifit (pid=<number>) exited with code 4: 
File error

HPI fit failed to load or create some file. 

Showing HPI results error: hpifit (pid=<number>) exited with code 5: 
Misc error

HPI fit failed to process the data.

Showing HPI results error: hpifit (pid=<number>) exited with code 6: 
Could not create transformation. Check coil 
placement

HPI fit failed to create transformation. 

Showing HPI results error: hpifit (pid=<number>) exited with code 
<number>: <explanation>. HPI fitting results 
access failed

Internal system error. The HPI results file
readable. 

Showing HPI results error: hpifit (pid=<number>) exited with code 
<number>: <explanation>. HPI fitting results 
read failed: <error>

Internal system error. The isotrak or HPI r
is invalid. 

Showing HPI results warning: hpifit (pid=<number>) exited with code 
7: Goodness-of-fit too low. Maybe you should try 
to place the coils higher. <HPI fitting results>

HPI fit suggests that HPI should be redon

Showing HPI results warning: hpifit (pid=<number>) exited with code 
8: Too large discrepancy between Isotrak and coil 
fitting. Maybe you should try to place the coils 
higher. <HPI fitting results>

HPI fit suggests that HPI should be redon

Table 1: 
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 restarting Please contact MEGIN Customer Care.

 toggling Please check log for more information.

toggling Please check log for more information.

e measure- Please contact MEGIN Customer Care if this 
error repeats.

e measure- Please contact MEGIN Customer Care if this 
error repeats.

 activat-
ation.

Please check log for more information.

 deacti-
ormation.

Please check log for more information.

surement Please contact MEGIN Customer Care if this 
error repeats.

surement Please contact MEGIN Customer Care if this 
error repeats.

 activat-
ck log for 

Please check log for more information.

 deacti- Please check log for more information.

Actions
Restarting measurement Could not restart acquisition! Something unexpected happened while
the ongoing measurement.

Activating stimulation Could not start stimulation! Something unexpected happened when
the stimulation on.

Deactivating stimulation Could not stop stimulation! Some unexpected error occurred when 
the stimulation off.

Activating averaging to_averager: <error> Averager communication failed. Stop th
ment and try to start it again.

Deactivating averaging to_averager: <error> Averager communication failed. Stop th
ment and try to start it again.

Activating recording Could not start recording! Something unexpected happened when
ing recording. Check log for more inform

Deactivating recording Could not stop recording! Something unexpected happened when
vating recording. Check log for more inf

Activating continuous HPI to_hpi: <error> HPI communication failed. Stop the mea
and try to start it again.

Deactivating continuous HPI to_hpi: <error> HPI communication failed. Stop the mea
and try to start it again.

Activating calibration signal Could not start eeg calibration signal! Something unexpected happened when
ing the EEG calibration signal. Please che
more information.

Deactivating calibration sig-
nal

Could not stop eeg calibration signal! Something unexpected happened when
vating the EEG calibration signal.

Table 1: 
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Actions

xpected Check opto-cabling to EEG rack, powering of 
EEG rack, EEG board insertion snugness, EEG 
board id configuration. Do a RAP after correct-
ing errors.

expected Check opto-cabling to MEG preamplifiers, pow-
ering of the MEG preamplifier bus, MEG board 
insertion snugness, MEG board id configura-
tion. Do a RAP after correcting errors.

y to all 
ally due to 
 to 
ork config-
r system 

Reset FEC, wait for boot-up and do a RAP.

minated, Check ethernet connections, firewall.

See description for <PROBLEM>.

See description for <PROBLEM>.

y due to 
r ongoing 

You need to close down and take a RAP and 
retry.

ver cannot 
ing 
eouting 

Do a RAP. If not helpful, check connections, fire-
wall and finally do a RAP.
Table 2: 

Context Message Description

Powering up system Could not initialize EEG electronics EEG electronics did not behave fully as e
during bringing up the system.

Powering up system Could not initialize MEG electronics MEG electronics did not behave fully as 
during bringing up the system.

Powering up system Connection to FEC failed! Cannot do anything. The operating of the connection gatewa
front-end electronics failed. This is typic
network connectivity problems, e.g. due
changes in network infrastructure, netw
urations, IP addresses, or plainly irregula
reset.

Any time Select socket timed out An ethernet connection has abruptly ter
or the other end is not responding.

Any time Janitor-MEG: Command '<COMMAND>' causes: 
<PROBLEM>

Prefix to deeper error messages.

Any time Janitor-EEG: Command '<COMMAND>' causes: 
<PROBLEM>

Prefix to deeper error messages.

Any time Janitor-MEG gave an empty reply Generic fatal error in the servers, possibl
complete unresponsiveness due to othe
activities (probably faulting).

Starting Megacq No connection to the data server The acquisition application and data ser
communicate due to the data server hav
crashed, or being fully busy with e.g. tim
from non-existing connections.
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mmuni- Check a) ethernet cabling, b) The Run-status of 
all DSP boards inside electronics cabinet and 
reset if needed, c) IP address configuration on 
the workstation, d) Firewall settings. Do a RAP 
after fixing connections.

d 
perate.

Check IP addresses and hostnames.

tings from 
mpatible.

Create the set up anew.

d without 
 will not 
lly accord-

Typically due to typos in the DSP parameter 
scripts, or channel definitions for collector. 
Check also firewall settings.

See description for <PROBLEM>.

munica-
ue to DSP 

Reset the particular DSP boards and do a RAP.

 correct 
y not be 

Check EEG calibration file for typos, or do a RAP 
to restart a tangled EEG system.

ize all 'non-
ossible 

Use a different sampling rate, preferably a 
round number.

han the 
e that HPI 
lies even 

Use higher low-pass frequency and possibly 
higher sampling frequency too.

Check gantry sensors, their adjustments within 
filter cabinet and cabling. Compare to gantry 
'traffic lights'.

Actions
Starting Megacq 400 Connection failed: <DSP NAME> The acquisition application could not co
cate to all configured DSP boards.

Starting Megacq Data server does not want to listen to us The server process exists, is reachable an
responds but is configured not to intero

Loading setups 500 Recalling old setups is not supported with 
this system

You have tried to load measurement set
an earlier software release that is not co

Starting measurement 410 Could not setup all sources: <DSP NAME> Some DSP boards could not be configure
problems. Most likely data from that DSP
come in at all, or will not be processed fu
ing to requested settings.

Starting measurement 402 Problems while switching to meas mode: 
<PROBLEM>

Prefix to deeper error messages.

Starting measurement Previously disconnected The acquisition application has lost com
tion to one or more DSP boards, usually d
board malfunction.

Starting measurement Channel <EEG CHANNEL>: Cannot find a calibra-
tion for the current gain (<NUMBER>, available 
<NUMBER>)

The EEG channel could not be set up for
gain, thus the values of that channel ma
correct.

Starting measurement The SQUID loop rate deviates too much with the 
selected sampling rate - please adjust it

The data sampling loop rate cannot real
round' values but attempts the nearest p
value.

Starting measurement Low-pass filter corner too low for HPI, should be 
at least <NUMBER> Hz

The low-pass filter cannot be set lower t
highest HPI frequency in order not to los
signal. This restriction unfortunately app
though no HPI would actually be used.

Starting measurement Invalid gantry position information (<code>) Gantry position value is invalid.

Table 2: 

Context Message Description



D
A

TA
 A

C
Q

U
IS

ITIO
N

N
M

23732A
-B1

Error m
essages

68

e offset 
ystem has 
he point 
 the EEG/
 or a fail-

Investigate and correct electrode connections. 
Restart measurement.

nsive and, 
ly for 

Check control connections, powers. Reattempt 
the measurement.

eir offsets. 
eout 

If single channel problem, note this and the use 
can be continued. Otherwise investigate and 
correct electrode connections.

eir offsets. 
eout 

If single channel problem, note this and the use 
can be continued. Otherwise investigate and 
correct electrode connections.

d and this 
den.

Check gantry position cabling, the traffic-lights, 
feed-through boards to correct the automatic 
detection, or, enter the gantry angle manually 
from acquisition application main window.

 (Max-
n cannot 
ompro-

until cor-

Retry measurement but if persists, verify that all 
DSP participating in the IAS are fully opera-
tional, possibly resetting the DSP boards and 
taking a RAP, or minimally, issue manually com-
mand 'ias off' to collector.

hile trying 
t.

Toggle off the EEG Calibration signal from the 
check box on the Megacq.

ance Check the cabling of the EEG rack. Take a RAP, 
and retry.

 excessive 
tation. 
le of stay-

Check ethernet connections and ethernet 
infrastructure loads. Also ensure that worksta-
tion is not excessively stressed during measure-
ment. Stop acquisition and retry.

Actions
Starting measurement Taking too much time, bailing out. The EEG system took too long time in th
calibration process. As a result, the EEG s
been set up properly for use only up to t
when time limit was exceeded. Typically
BIO connectors were wrongly connected
ure in the EEG electronics.

Starting measurement EEG control failed right away! Bailing out. The EEG system was completely unrespo
as a result, it has not been set up proper
measurement.

Starting measurement Channel <name>: Offset too high. Possibly an 
open input?

Some EEG channels failed to calibrate th
Other EEG channels are ok, unless the tim
problem ensued as a result of this.

Starting measurement Channel <name>: Offset calibration failed. Some EEG channels failed to calibrate th
Other EEG channels are ok, unless the tim
problem ensued as a result of this.

Starting measurement Gantry position has not been defined manually! The gantry position signal path has faile
situation has not been manually overrid

Starting measurement 403 MaxShield state unknown - cannot measure. 
Turn MaxShield on or off

The system could not command the IAS
Shield) subsystem fully. Thus its operatio
be guaranteed and thus data validity is c
mised. Measurement will be prohibited 
rected.

EEG impedances Switch off calibration signal first. The calibration signal is still turned on w
to engage EEG impedance measuremen

EEG impedances Could not setup oscillator! The oscillator that is used for EEG imped
measurement failed to start.

During measurement Data no longer available! Acquisition workstation 
is probably overloaded.

The MEG signal data has been lost due to
lagging in data processing on the works
Thus the workstation is no longer capab
ing in real-time status.

Table 2: 
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r for some 
ment. 
data most 

Check ethernet connections and ethernet 
infrastructure loads. Also ensure that worksta-
tion is not excessively stressed during measure-
ment. Analyze the data with additional care.

s during 
tuation, 
s during 

Check for prior error messages, otherwise the 
system use can be continued.

g MEG 
 The data 
ely valid, 

This can be due to ethernet cabling failure, eth-
ernet software bug, or excessive ethernet load. 
Check administration interface of the ethernet 
switches too for collisions or other physical 
faults. Otherwise reset the particular DSP and 
restart Megacq.

Actions
During measurement Large gap in source data! The MEG signal data is missing altogethe
period of time in the middle of measure
Expect data gaps during analysis. Other 
likely fully valid.

Stopping measurement 401 Acquisition did not stop gracefully: Sampling 
clock was turned off but ODP thread did not exit

Typically ensues after other root problem
measurement. Typically a recoverable si
but indicates presence of other problem
measurement.

Stopping measurement ERROR: These data sources dropped out in the 
middle of the measurement: <DSP NAMES>

The listed DSP boards stopped supplyin
data in the middle of the measurement.
up to that point may exist and is most lik
but afterwards is probably flat.

Table 2: 

Context Message Description
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